NEXT GENERATION MEMS DESIGN TOOLS

Tanner Research, Inc.

Sponsored by
Defense Advanced Research Projects Agency
DARPA Order No. E117/6220

APPROVED FOR PUBLIC RELEASE; DISTRIBUTION UNLIMITED.

The views and conclusions contained in this document are those of the authors and should not be interpreted as necessarily representing the official policies, either expressed or implied, of the Defense Advanced Research Projects Agency or the U.S. Government.
This report has been reviewed by the Air Force Research Laboratory, Information Directorate, Public Affairs Office (IFOIPA) and is releasable to the National Technical Information Service (NTIS). At NTIS it will be releasable to the general public, including foreign nations.

AFRL-IF-RS-TR-2001-201 has been reviewed and is approved for publication.

APPROVED: ROBERT G. HILLMAN
Project Engineer

FOR THE DIRECTOR: NORTHUP FOWLER, III, Technical Advisor
Information Technology Division
Information Directorate

If your address has changed or if you wish to be removed from the Air Force Research Laboratory Rome Research Site mailing list, or if the addressee is no longer employed by your organization, please notify AFRL/IFTC, 26 Electronic Pky, Rome, NY 13441-4514. This will assist us in maintaining a current mailing list.

Do not return copies of this report unless contractual obligations or notices on a specific document require that it be returned.
NEXT GENERATION MEMS DESIGN TOOLS

Barry Dyne

Contractor: Tanner Research, Inc.
Contract Number: F30602-96-2-0311
Effective Date of Contract: 1 October 1996
Contract Expiration Date: 31 December 1999
Short Title of Work: Next Generation MEMS Design Tools
Period of Work Covered: Oct 96 – Dec 99

Principal Investigator: Barry Dyne
Phone: (818) 792-0300
AFRL Project Engineer: Robert G. Hillman
Phone: (315) 330-4961

Approved for public release; distribution unlimited.

This research was supported by the Defense Advanced Research Projects Agency of the Department of Defense and was monitored by Robert G. Hillman, AFRL/IFTC, 26 Electronic Pky, Rome, NY.
**Title and Subtitle: NEXT GENERATION MEMS DESIGN TOOLS**

**Performing Organization Name and Address:**
Tanner Research, Inc.
2650 E. Foothill Blvd.
Pasadena, CA 91107

**Sponsoring/monitoring Agency Name and Address:**
AFRL/IFTC
26 Electronic Pky
Rome, NY 13441-4514

**Supplementary Notes:**
AFRL Project Engineer: Robert G. Hillman, IFTC, 315-330-4961

**Abstract:**
The objective for this project has been to lower the barriers to MEMS technology through the development of an integrated suite of CAD tools for mixed technology design. Tanner has achieved new levels of integration of layout, solid modeling, and finite element analysis for MEMS device design and verification. Tanner has developed a modeling tool that generates a solid model directly from the layout and a process description. Tanner has also developed a novel approach to MEMS device meshing, dramatically improving the efficiency of finite element analysis. System design tools developed include mixed technology schematic, simulation, place and route, extraction and design rule checking. These tools enable the design, physical layout, and validation of chips of mixed MEMS/IC components. Simulation tools allow the use of a variety of models including C-code, Spice, and MATLAB, necessary for the design of mixed technology chips. A library of components contains a schematic, simulation, and layout representation of each device, and device layout may be synthesized from functional or geometric parameters. The tools have been demonstrated at a number of commercial and government sites, and are now in commercial release.

**Subject Terms:**
MEMS, micro-electro-mechanical systems, mixed-technology, EDA, modeling, finite element

**Security Classification of Report:**
UNCLASSIFIED

**Security Classification of This Page:**
UNCLASSIFIED

**Security Classification of Abstract:**
UNCLASSIFIED

**Number of Pages:**
68

**Price Code:**
UL
Table of Contents

1. RESEARCH STATUS ........................................................................................................... 1
   1.1. INTRODUCTION ........................................................................................................ 1
   1.2. PHYSICAL DESIGN ................................................................................................... 1
       1.2.1. Solid Modeling .................................................................................................. 1
       1.2.2. Process Specification ....................................................................................... 8
   1.3. LIBRARIES AND TECHNOLOGY SETUP FILES .................................................. 10
       1.3.1. Canonical Design Problem: High Q Resonator ............................................. 11
   1.4. FINITE/BOUNDARY ELEMENT ANALYSIS .......................................................... 12
       1.4.1. Mesh Generation .............................................................................................. 13
       1.4.2. Finite Element Mechanical, Thermal, and Electrostatic Analysis .............. 18
       1.4.3. Integrated CoSolver ......................................................................................... 20
       1.4.4. Results Rendering ............................................................................................ 21
   1.5. MODEL BUILDER ...................................................................................................... 21
       1.5.1. Model Builder Architecture .............................................................................. 22
       1.5.2. Model Builder Algorithms .............................................................................. 22
       1.5.3. Model Builder Example -- Generating a T-Spice Macromodel of an Accelerometer Using IMSET and ANSYS ......................................................... 23
   1.6. CIRCUIT REFINEMENT SUITE AND MIXED-LANGUAGE MACROMODEL SUPPORT ................................................................. 35
       1.6.1. Schematic Tool Multi-domain Enhancements ................................................. 36
       1.6.2. Mixed Language Models ................................................................................ 37
       1.6.3. Matlab Modeling and Mechanical and Thermal Behavioral Simulation .... 37
   1.7. LAYOUT SYNTHESIS AND VERIFICATION ......................................................... 39
       1.7.1. Mixed Technology Place and Route ............................................................... 39
       1.7.2. Multidomain Layout Extraction ..................................................................... 43
       1.7.3. Design Rule Checking ..................................................................................... 44
   1.8. PROGRAM MANAGEMENT ...................................................................................... 48
   1.9. APPLICATIONS ENGINEERING AND PRODUCTIZATION .................................. 49

2. PROGRAM MILESTONES ................................................................................................. 50

3. SCHEDULE ....................................................................................................................... 51

4. PERSONNEL STATUS .................................................................................................. 51

5. TALKS/PRESENTATIONS .............................................................................................. 52
List of Figures

Figure 1: Solid model integrated with L-Edit ...................................................... 3
Figure 2: Hierarchical layout example, showing an instance of a switch device, a 2x2 array of the device, and horizontal and a rotated instance of the device, and the 3D model of the horizontal and rotated device .................................................. 4
Figure 3: Intermediate process steps of a thermal actuator, i) after step 8, etch anchor 1, ii) after step 10, etch poly 1, iii) after step 16, etch poly 2, and final 3D model .......................... 5
Figure 4: Curved layout primitives and 3D model support. Insert shows dialog for editing tori using Begin and End Angles, and Inner and Outer Radius ................................................................. 6
Figure 5: Illustration of height scaling of cross section ........................................ 7
Figure 6: Rome Labs design, illustrating hidden layers feature of 3D modeling tool. Layout (top-left), 3D model close up with all layers (bottom-left), and 3D model close up with metal2, metal3, and oxide hidden (right) ...................... 7
Figure 7: Sample Process Definition Steps from MUMPS Process ......................... 9
Figure 8: Graphical input option for process definition data. Process may be imported from text file by pressing the “Import” button ........................................ 10
Figure 9: Parameterized Layout Library Selection Palette .................................. 11
Figure 10: Comb Drive Parameters Dialog Box .................................................. 11
Figure 11: Canonical Design Problem .................................................................. 12
Figure 12: 2D mesh of hinge mechanism ....................................................... 14
Figure 13: 3-D mesh of hinge mechanism .......................................................... 15
Figure 14: Face extraction method, 12,585 elements ........................................ 16
Figure 15: Remeshing algorithm, 3029 elements. (No area ratio constraint) ...... 16
Figure 16: Remeshing algorithm, 9509 elements. (Area ratio limited to 20:1) ...... 17
Figure 17: Illustration of new bitree meshing approach .................................... 18
Figure 18: Displacement of beam due to applied voltage .................................... 19
Figure 19: Integrated Layout, Solid Model, and Analysis Results .............. 21
Figure 20: Accelerometer .................................................................................. 24
Figure 21: Accelerometer Parameters Dialog .................................................. 27
Figure 22: Generated layout for default values of \( a \) and \( b \) .................................. 29
Figure 23: Generated layout using demo.dat ..................................................... 29
Figure 24: Generated layout using accel.dat ..................................................... 30
Figure 25: 3D model generated for \( a=505 \), \( b=26 \), and \( \text{Cell Name} = \text{"N38_A505_B26"} \) .......................... 31
Figure 26: Schematic symbol of the Accelerometer Macromodel ..................... 34
Figure 27: Test Circuit for the Accelerometer Macromodel ................................. 34
Figure 28: Plot of Z vs. \( A_1 \) .............................................................................. 35
Figure 29: Tanner Toolbar ................................................................................ 37
Figure 30: Flow Diagram for T-Space/MATLAB Interface ......................... 38
Figure 31: Block place and route of Q-controlled resonator, illustrating initial placement of cells. Red lines connecting cells are the rats nest ................................................. 40
Figure 32: Block place and route of Q-controlled resonator, illustrating manually placed design. Note rubberbanding of connections as block on lower left is moved ...................... 41
Figure 33: Block place and route of Q-controlled resonator, illustrating routed design ... 41
Figure 34: AFRL MES-Push design, placed using BPR .................................... 42
Figure 35: AFRL MEMS Push design, blocks routed using BPR .................... 43
Figure 36: Resonator layout with properties of comb drive ............................... 44
Figure 37: Illustration of all-angle Boolean and selection operations for MEMS .... 45
Figure 38: Dialog boxes for multiple rule setup .............................................. 46
Figure 39: Linear resonator with etch holes in the plate mass. Selectively check for density of etch holes only in plate area of poly1 layer, but not in comb or spring areas .......... 47
Figure 40: Results of DRC check for etch hole density with rule applied to entire layout. Green color shows violation of etch hole density rule ......................................................... 48
Figure 41: Results of DRC check for etch hole density, with rule applied selectively to plate area. Green color shows violation of etch hole density rule ............................................. 48
1. Research Status

1.1. Introduction

This is the Final Report for the contract, covering new work since July 1, 1999, and summarizing the complete program since its start date on October 1, 1996. The original end date of the contract was September 30, 1999, however an extension was granted to December 31, 1999. Contract billing reached the allocated total amount with the October 1999 bill, so this report covers all work done under the contract.

The program consists of five major task areas, i) physical design, including solid modeling, visualization, and library management, ii) finite element analysis, iii) macromodel generation, iv) schematic, simulation, and modeling, and v) layout synthesis and verification. Detailed progress on each of these areas is described below.

1.2. Physical Design

This task consists of development of a process specification, 3-D solid model generation, and rendering capability, giving the MEMS designer the ability to create and visualize the 3-D structure of a MEMS device during the design phase, prior to fabrication. The solid model is generated automatically from 2-D layer based layout data in the Tanner layout editor L-Edit, combined with a process specification. This tool provides a visual design verification aid prior to fabrication, and also provides 3D models for input to analysis tools for further verification and simulation. A designer can use this tool to ensure that the 2D layout they create has the intended 3D structure and function when fabricated. Also included in this task is component library generation and management.

1.2.1. Solid Modeling

<table>
<thead>
<tr>
<th>Highlights:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Commercial release of Solid Model module in MEMS-Pro V2.</td>
</tr>
<tr>
<td>• Developed 3D modeling and viewing tool, tightly integrated with layout editor, featuring the following capabilities:</td>
</tr>
<tr>
<td>• 3D model generation for process steps deposit (conformal, snowfall, fill), etch (bulk, surface, sacrificial), and mechanical polish.</td>
</tr>
<tr>
<td>• Checking of 3D model for synchronization with layout and process definition.</td>
</tr>
<tr>
<td>• Support of boxes, polygons, circles, arcs, tori, curved polygons, including hierarchical layout.</td>
</tr>
<tr>
<td>• Edit of process definition via a user friendly dialog, or file input</td>
</tr>
<tr>
<td>• Cross-Section viewing</td>
</tr>
<tr>
<td>• 3D model viewing with pan, zoom, rotate, spin, and color controls</td>
</tr>
<tr>
<td>• Hide layers, enabling the user to see layers that are obstructed or covered by subsequent layers.</td>
</tr>
<tr>
<td>• Display Intermediate Process Steps</td>
</tr>
</tbody>
</table>
In the previous period Tanner culminated its push toward commercialization of the 3D solid modeling tools with the release of MEMS-Pro V2. Pre-release beta versions were sent to commercial sites for evaluation, including a copy sent to the contract monitor at AFRL. The final product included documentation, tutorials, examples, and technology configuration files. Details on specific features are provided below.

**Database Synchronization/Integrated Layout and 3D Model**

In the Tanner system, the 3D modeling tool is tightly integrated with the layout editor, allowing us to leverage a number of capabilities that would not be possible in a stand-alone tool. Figure 1 shows a view of the integrated system, with multiple windows showing the layout and 3D model simultaneously. The user can maintain a view of the entire model in one window, while zooming in on key features in another window.

A key feature of the Tanner system is that 3D models are stored directly in the layout database, allowing a 3D model to be stored for each cell in the design. This alleviates the burden from the user of keeping track of which 3D model files correspond to which layout cells. Tanner has also implemented the ability to perform synchronization checking between the layout, the process definition, and the 3D model. Upon request to view an existing 3D Model, the user will be notified if the layout or process has been modified since the 3D model was created, and given the option to view the old model or to regenerate a new one. This feature protects the user from accidentally viewing and exporting to analysis models that do not correspond to the structure that will be fabricated, and potentially from fabricating a device that fails to meet spec.
Hierarchical Layout Support

By tightly integrating the 3D modeling tool with the layout editor, Tanner is able to take advantage of many of the features present in the layout editor. In particular, Tanner has implemented the capability in the 3D modeling engine to support hierarchical layout. Layout may contain instances of cells, rotated instances, as well as arrays of instances, and cells may be instanced, rotated, and arrayed to any level of nesting. Figure 2 shows an example of an instance of a switch, a 2x2 array of the switch, a horizontal and rotated instance, and the 3D model of the horizontal and rotated devices.

The user then has two ways to partition the design for analysis, first, he can use hierarchy to partition the design by placing components to undergo 3D modeling and analysis into separate cells. These cells then get modeled separately from the top level cell. The second approach allows the user to simply draw a box around the area to be modeled. Using this capability the user can perform 3D modeling of the device completely within the environment of the entire system design, and if necessary, surrounding circuit components may also be included in the model. The user simply draws a box on the layout identifying the region to model, and the region enclosed by the box is processed for 3D modeling. Any level of hierarchy may be present inside the box.
Disable Process Steps/Display Intermediate Process Steps

In many cases, the complete fabrication process is more detailed than what is needed for 3D modeling or analysis purposes, so Tanner has implemented the ability to disable steps in the process definition. Using this feature, the user can disable certain steps to simplify the resulting model, such as removing etching of holes, or can improve performance for a given design if it is known that certain steps are not needed.

Tanner has also implemented the ability to display intermediate process steps. This enables the user to verify that the sequence of processing steps is acting correctly on the layout, and also lets the user verify that a structure does not collapse midway through processing. The feature is illustrated in Figure 3 which shows the intermediate process steps of a thermal actuator with the MUMPS process. Four intermediate steps are shown i) step 8, etch anchor, ii) step 10, etch poly1, iii) etch poly2, and iv) final 3D model. After step 8 one can see the holes in the oxide layer for the anchor and dimples.
Figure 3: Intermediate process steps of a thermal actuator, i) after step 8, etch anchor 1, ii) after step 10, etch poly1, iii) after step 16, etch poly 2, and final 3D model.

**Curved object support (arcs, tori, polygons)**

Tanner has recently implemented curved layout drawing primitives, including arc, tori, and polygons with curved sides. Tanner has also implemented support for these structures in the 3D modeling tool. These objects are very useful in creating torsional resonator components (shown in Figure 4), motors and other devices with curved layout. Tori for example may be edited by the inner and outer radius, and start and end angle, options typical in a mechanical drawing tool but not usually found in a IC/MEMS layout tool. These parameters make manipulation of curved elements far easier than using straight line approximations as previously required. In the example below, Tanner has used another feature, the ability to rotate instances by any angle, to create different interlocking between the fixed and moving elements of the resonator.
Height Scaling

The layers from which MEMS devices are fabricated are often very thin in relation to the horizontal extent of the device. In viewing cross sections it is sometimes difficult to distinguish features. Tanner implemented the capability to scale the cross section view to either stretch, or shrink if desired, the height of the device. This is illustrated in Figure 5, which shows a cross section of a comb drive device using no scaling, and scaling by a factor of 3.
Hide layers in 3D Viewer

In many cases the layer of interest in a device is hidden by other layers or obscured from sight in some way. During this quarter Tanner has implemented the ability to hide any layer in the 3D model, thus bringing the layers under the hidden layer into view. A hidden layer may easily be brought back into view as well.

Figure 6: Rome Labs design, illustrating hidden layers feature of 3D modeling tool. Layout (top-left), 3D model close up with all layers (Bottom-left), and 3D model close up with Metal2, Metal3, and oxide hidden (right).

Recent Developments
Additional work this period includes development not included in the release version, but may be released in a future version. Stretching of the vertical axis in the cross section view, export of only the visible portion of the 3D model, as well as conformal deposition onto angled sidewalls was implemented this period.

1.2.2. Process Specification

The process specification is a set of steps that is used to describe a fabrication process. Tanner has developed a process specification that is an abstraction of the true fabrication process, as it describes steps in terms of their geometric effect, rather than in terms of material and chemical inputs. It provides the Solid Model Generator with instructions on building a 3-D model from the 2-D layout.

<table>
<thead>
<tr>
<th>Highlights:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Developed fabrication process definition format adopted by Composite CAD as standard.</td>
</tr>
<tr>
<td>• Iterated review of the fabrication process definition format among Composite CAD members.</td>
</tr>
<tr>
<td>• Completed a BNF description of the process definition specification.</td>
</tr>
<tr>
<td>• Implemented parser to read process definition format.</td>
</tr>
<tr>
<td>• Created process definition files for standard processes including MUMPS, SANDIA ITT, and Analog Devices/MCNC iMEMS.</td>
</tr>
</tbody>
</table>

A main goal in the development of the format is that it be easily extensible to future process steps and parameters. In this regard, the most notable feature of the format to come out of the Composite CAD discussion involves combining several similar steps into a single step with a type parameter. This leads to a system of hierarchy and inheritance, and enables easier extension to new types, as well as allows a default behavior to be executed if a particular type is not supported. In particular,

- Conformal Deposit, Snowfall Deposit, and Fill, are combined into a single "Deposit" step, with a DepositType parameter to indicate the type of deposition. This implementation is more extendable to allow for a default behavior, and to add more deposit types.
- The separate steps for Etch, Bulk Etch, and Sacrificial Etch are combined into a single "Etch" step, with an "EtchType" parameter to indicate the type of etch.

Some sample steps from the MUMPS process are shown in Figure 7 below.

```sh
Wafer={
  MaskName="substrate"
  Thickness=100
  Comment="Wafer"
}
Deposit={
  DepositType=CONFORMAL
  Face=TOP
  LayerName="Nitride"
  Thickness=.6

```
Figure 7: Sample Process Definition Steps from MUMPS Process

The process definition may be written as a text file, and parsed by the program, or the user may enter process parameters directly a GUI, as shown in Figure 8. Tanner has also created process definition files for standard processes including MUMPS, SANDIA ITT, and Analog Devices/MCNC iMEMS, which are provided to users with MEMS-Pro.
1.3. Libraries and Technology Setup Files

Under this effort Tanner has implemented technology setup files for a number of processes, including MCNC/MUMPS, MOSIS-CMU, Sandia-ITT, and ADiMEMS, and are distributing them in the latest release of MEMS-Pro. The technology files include layer setups, DRC rules, extraction setups, as well as process definition setup for 3D modeling.

In a related effort, Tanner has developed a set of parameterized layout libraries for resonator elements and have developed corresponding schematic and simulation models for each layout element. For each element, a synchronized three view system of layout, schematic, and simulation is provided. Tanner has also developed a graphical interface for easy point-and-click selection of desired components. The graphical interface displays icons of each component grouped by functional category in a tabbed dialog, as shown in Figure 9 below.
Figure 9: Parameterized Layout Library Selection Palette.

Clicking on the icon for the Comb Drive resonator element, for example, brings up the dialog box shown below in Figure 10. Here the user may enter the parameters for the creation of the Comb Drive, such as width and length of the teeth, width of the gap, and number of gaps.

Figure 10: Comb Drive Parameters Dialog Box.

1.3.1. Canonical Design Problem: High Q Resonator

As an illustration of the Library capabilities and concept, Tanner has worked with CMU on the canonical design problem of the High Q Resonator. Tanner has developed
all three views of this device, i.e., schematic symbol, simulation model, and layout macro. Tanner has developed 3D analytical models for the resonator using MEMS Pro to match the CMU results. A schematic of the resonator was created in S-Edit and the models were implemented using S-Edit schematics with links to T-Spice external functional models. Figure 11 below shows the S-Edit schematics, T-Spice netlist, W-Edit simulation results, and L-Edit layout of a particular resonator design.

Figure 11. Canonical Design Problem

1.4. Finite/Boundary Element Analysis

This task consists of the development of Self-Consistent Finite Element and/or Boundary Element analysis capability for multidomain Electrostatic, Mechanical, and Thermal analysis. Initial efforts centered on development of solvers either from scratch or based on University developed solvers. Progress from this approach was evaluated midway through the program, and a decision was made that partnering with a commercial FEA company was a better strategy. Tanner established a joint development relationship with ANSYS as well as have developed a strategy for inclusion of the ANSYS tools in MEMS-Pro. The ANSYS software provides capabilities for coupled multiphysics analysis, including mechanical, thermal, electrical, magnetic, and fluidic analysis. The tool is capable of analyzing material nonlinearity, geometric nonlinearity, large deflection analysis, as well as contact nonlinearities. Although 3rd party solvers are being used, Tanner is developing its own mesh generation technology that will be superior to ANSYS mesh generation for MEMS structures.

Tanner's approach follows a two-phase approach toward integration. In the first phase, MEMS-Pro provides 3D modeling, meshing, and problem definition (Boundary conditions), and outputs a data file for input into ANSYS. In the second phase, the ANSYS solver is completely embedded in MEMS-Pro, and the user interacts entirely through the MEMS-Pro user interface. Tanner's goal is to deliver a well integrated and
easy to use with ANSYS as the core solver engine. The user thus has the ease of use of the MEMS-Pro integrated design suite, with the power of the ANSYS engines underneath. Additional details on technical advancements toward integration of ANSYS into the Tanner tool suite are provided below.

1.4.1. **Mesh Generation**

<table>
<thead>
<tr>
<th>Highlights:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Developed automatic mesh generation algorithm, tightly interfaced with solid model, and optimized for MEMS/IC fabrication process derived structures.</td>
</tr>
<tr>
<td>• Finite element and Boundary element meshing.</td>
</tr>
<tr>
<td>• Independent mechanical, electrical, and thermal meshing.</td>
</tr>
<tr>
<td>• Support of curved geometry in mesher.</td>
</tr>
<tr>
<td>• Continued work on meshing approaches for angled sidewall meshing.</td>
</tr>
</tbody>
</table>

Mesh generation follows solid modeling in the analysis sequence. Tanner has developed a fully automatic meshing capability that requires no user assistance. Automatic mesh generation is especially important, since manual meshing is a laborious process often requiring several days to mesh a complex device. Both finite element volume meshing, and boundary element surface meshing algorithms are developed.

Tanner has developed a finite element meshing approach for that takes maximum advantage of the layered, process derived structure of the device. The algorithm involves projecting the solid model structure onto a 2D plane, meshing the projection, then extruding the 2D mesh into the 3D structure. The planar projection is meshed using a triangulation scheme, and is thus able to accommodate arbitrarily complex configurations. The advantage of this approach, is that the elements may be thin in the z dimension, but very large in the x-y plane, thus reducing the number of elements required to mesh the structure compared to the generalized tetrahedral approach commonly used. Tanner estimates a factor of 10 reduction in the number of elements, compared to tetrahedral meshing. In addition, the Tanner approach covers the domain with the minimum number of triangles required to fit the geometry, subject to constraints of element quality. The approach will then use a measure of the error in the solution to locally refine the mesh to reduce the error to a predefined tolerance. By starting with a coarse mesh, and refining based on the error in the solution, the method can establish the solution to a predefined tolerance, in the minimum required memory.

**Finite Element Mesh Generation**

The finite element meshing module is tightly interfaced with the solid model module, takes geometry directly from the solid model for meshing. The user simply sets initial mesh parameters, and the code automatically produces a mesh from the 3D model input. An example of a hinge mechanism is shown below. The mesh of 2-D projection of the hinge example is shown in Figure 12, and the corresponding 3-D mesh is shown in Figure 13.

Since the majority of detail in MEMS devices is in the horizontal plane, Tanner has spent effort to ensure high quality and efficient meshing in the triangulation of the solid
model projection. Tanner has investigated several criteria for triangulation refinement, and decided that using a triangle size measure produced superior results over using a triangle shape measure. The algorithm proceeds in roughly the following manner: an initial Delaunay triangulation is given which covers the domain of the computation, the mesh is then iteratively refined by placing nodes in areas which are computed to be “too coarse.” The algorithm terminates when no such areas remain on the mesh. A shape criteria (specifically, its aspect ratio, the ratio of the radii of its circumscribing to inscribing circles) provided strict control over the quality of the final mesh by terminating the algorithm when every triangle had aspect ratio equal to or less than a user defined limit. However it frequently produced meshes with too many elements. In an effort to eliminate badly shaped triangles, the algorithm overzealously refined areas of the mesh which could have been more economically covered. Also, because of the post-processing smoothing algorithm used, the quality of the final mesh would very often not satisfy the user limit. A size based criteria terminates when all triangles on the mesh are smaller than their local size function, regardless of their shape. In general, this tends to produce meshes with a minimum number of elements although some of them may be badly shaped. However, optimizations to the point placement strategy and the boundary refinement strategy, and the use of a mesh optimization algorithm have led to an overall algorithm that produces high quality coarse meshes with the fewest reasonably possible number of elements necessary to represent the geometry. Economy of meshes is important, since the goal is to be able to perform analysis on a PC. Performance of the meshing engine has also been optimized, and Tanner has achieved and $O(N \log N)$ complexity of the triangulation algorithm. The algorithm generated tens of thousands of triangles in just a few minutes. Lastly, an element merging postprocessing algorithm was developed to produce a quadrilateral mesh from the triangulation. In the 3D mesh, this results in a higher quality brick mesh vs a tetrahedral mesh.

![2D mesh of hinge mechanism.](image)

Figure 12: 2D mesh of hinge mechanism.
Boundary Element Mesh Generation

Tanner's approach toward 3D analysis is to allow a flexible combination of finite element and boundary element solvers to be used. In many cases, a boundary element solver is desired for electrostatic analysis. In this case, only the boundary of the domain need be meshed when using a BE approach, whereas an external unbounded domain must be meshed if a finite element approach is used. Thus, Tanner has developed both boundary element and finite element meshing, and the user will be able to choose the type of solver to be used in a given problem. In the initial approach to BE meshing, the boundary element mesh was simply the surface elements of the finite element mesh. The boundary element meshes produced by this approach were too fine for efficient electrostatic analysis so it was decided that the boundary element and finite element meshes should be completely independent. Boundary element electrostatic solvers typically support nonconforming meshes, so this fact was take advantage of to produce much coarser initial meshes. The mesh is further refined based on an error criteria in the solution, and the solver iterates with mesh refinement until convergence.

Since the electrostatic BE solution needs to be coupled to a structural FE solution for self consistent analysis, an approach has been implemented to perform cross mesh interpolation between the finite element conforming and boundary element nonconforming meshes.

Figure 14 below shows a boundary element mesh of a resonator, obtained by extracting the surface of the finite element structural mesh. Figure 15 shows a nonconforming boundary element mesh of the same resonator, obtained independently of the finite element mesh. Note the dramatic reduction in the number of elements, from 12,585 elements, to 3029 elements, for a 76% reduction. In practice however, FastCap will not be able to obtain a solution on the mesh in Figure 15, due to the high area ratio between the largest and smallest elements. Tests of various structures have shown that
FastCap is able to obtain solution for area ratios of largest to smallest element of about 20:1.

Figure 14: Face extraction method, 12,585 elements.

Figure 15: Remeshing algorithm, 3029 elements. (No area ratio constraint)

Applying this constraint to the nonconformal boundary element mesh produces the mesh shown in Figure 16. This mesh contains 9099 elements, for a 28% reduction from the original. While containing fewer elements, the nonconforming mesh in Figure 16 is a
superior mesh for electrostatic analysis as the element distribution is more uniform than the original one obtained by the face extraction method.

Figure 16: Remeshing algorithm, 9909 elements. (Area ratio limited to 20:1)

**ANSYS Link**

The finite element mesh generator has the ability to output a mesh in a format directly readable by the ANSYS finite element solver. In addition to the structural FEA mesh, Tanner is able to generate an electrostatic FEA mesh for use by the ANSYS electrostatic solver. Tanner uses the ANSYS “infinite” elements for the far field boundary, and has made needed modifications to the mesher to handle these special elements. The approach essentially consists of building a large sphere of elements around the body, with infinite elements on the outer boundary of the sphere.

**Angled Sidewall Meshing**

Cases in which only the substrate layer has angled sidewalls can be handled by using a combination of the current Tanner mesher and the ANSYS tetrahedral volume mesher. In this scheme, the Tanner mesher meshes the layers above the substrate. The bottom surface of this mesh are then given to ANSYS along with a solid model of just the substrate layer. ANSYS is then be instructed to generate a volume tetrahedral mesh in this volume while preserving the surface mesh produced by the Tanner mesher. The two meshes are then perfectly matched on the surface defined by the surface mesh.

To handle the general case of angled sidewall solid models Tanner has worked on a new meshing scheme that is a variation on the well-known octree method, but is tailored to produced high quality but very thin elements as the extrusion method does. It will achieve this by allowing the root box of the octree to be a suitably flat rectangular solid and by using bisection rather than octasection to refine the tree (hence it is properly referred to as a bitree method). The bisection algorithm is specified to take into account
the layered nature of the solid model so as to produce as few elements as possible. A preliminary result is shown in the figure below. Note that no layering information was used in this example (only a simple solid model in/out function) so that the bitree is more fine than it otherwise could be.

![Figure 17: Illustration of new bitree meshing approach.](image)

**1.4.2. Finite Element Mechanical, Thermal, and Electrostatic Analysis**

**Highlights:**
- Initial approach was to develop new mechanical and thermal solvers, and use the Fastcap electrostatic solver.
- Strategy changed to interface tightly to the ANSYS FEA solver, with ability to interface to other 3rd party solvers.
- Developed novel approach to boundary conditions, allowing the user to label FEBE boundary conditions on the mask layout.
- Implemented capability to setup capacitance calculation in MEMS-Pro, and invoke ANSYS to calculate the capacitance matrix.

**Boundary Conditions/Problem Setup**

Tanner has developed an easy to use front end for the finite element analysis tools. By leveraging on its highly integrated layout and 3D modeling environment Tanner has developed a number of capabilities to simplify the analysis process for the designer, particularly in the area of design iteration and boundary condition management. In the typical design environment today, a change in layout requires a new 3D model to be generated for analysis. Boundary conditions on the old model or mesh are lost, and new ones must be created.
The approach is to push as much of the analysis setup and boundary condition information as possible onto the layout. Data specified on the layout will be persistent throughout the design cycle. The user is able to modify the layout and when analysis is invoked, boundary condition data specified on the layout will be automatically transferred to the solid model and then to the mesh. The work of having to reapply boundary conditions every time the design is modified is thus avoided. By using special tags on the layout, the tool is also able to automatically calculate fixed boundary conditions.

**Initial Analysis Approach**

The initial approach to 3D analysis in this contract was to develop new finite element solvers for mechanical and thermal analysis, and a new boundary element solver for electrostatic analysis. At DARPA’s suggestion Tanner modified its strategy for electrostatic analysis to use the MIT developed Fastcap code. Tanner has been successful in developing a prototype structural solver, and coupling the Fastcap solver in a self-consistent solution algorithm. Results from that prototype are shown in Figure 18 depicting the deflection of the sample beam resonator due to the applied voltage.

![Figure 18: Displacement of beam due to applied voltage.](image)

While this approach enabled a highly customized solver for MEMS applications, several factors led us to conclude that this was ultimately not the best strategy to continue. Notably, the fastcap solver had difficulty converging on large meshes with large ratios of largest to smallest element size. Also, the Fastcap solver exhibited convergence difficulties when the ratio of the largest to smallest dielectric constant was large. Modifications were made to address these issues, with some improvement, but it appeared that a commercially robust solver would be difficult to achieve. The internally developed structural solver was also successful in prototype runs, but appeared to have serious limitations in capacity. Having identified these shortcomings, the decision was made to interface with the ANSYS finite element solver for 3D analysis. This decision was discussed and approved by Heather Dusselt, the DARPA program manager at the time.
ANSYS Interface

Tanner has developed two approaches for easily interfacing from Tanner's MEMS-Pro to ANSYS. In the first approach, the user can write the solid model in a format which can be directly read into ANSYS. The user can then easily import the solid model into ANSYS, and perform any meshing and analysis functions normally available with their ANSYS product. This capability is available in MEMS-Pro V2. Tanner has also developed a second approach, which involves a much more tightly integrated product. In this approach the user meshes the solid model using the Tanner mesher, and controls ANSYS from within MEMS-Pro. This happens in two steps: first MEMS Pro outputs a batch file containing all information necessary for ANSYS to perform a particular analysis, and then instructs ANSYS to execute the commands in the batch file. The batch file manipulations are completely transparent to the user, who controls the process from the MEMS-Pro GUI. Currently the batch file is concluded by instructing ANSYS to write all information about the analysis, including the solution, into a database file which can be used for visualization.

1.4.3. Integrated CoSolver

<table>
<thead>
<tr>
<th>Highlights for this quarter:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Developing interface to ANSYS solvers, with ability to setup multiphysics analysis.</td>
</tr>
</tbody>
</table>

Tanner has developed the ability to interface MEMS-Pro to the ANSYS finite element solver for coupled self consistent multidomain analysis. The approach has centered around writing ANSYS command files which instructs the ANSYS engine how to perform the solution in a batch mode operation. Such routines have been written for static structural and electrostatic analysis. The former can also be used to perform a structural modal analysis. Tanner has also prototyped the capability to invoke an ANSYS analysis directly from MEMS-Pro.

Tanner is also performing research into algorithms for coupled multiphysics analysis in order to be able to properly evaluate the ANSYS solvers, and to provide guidance to ANSYS on their approach. In this regard, Tanner is working in collaboration with two members of the applied mathematics department at the California Institute of Technology (Drs. John Pelesko and Patrick Guidotti). In this work a mathematical model of a simple electrostatically actuated MEMS device was constructed and the mathematical properties of the model explored. The purpose is to better understand the nature of this type of coupling with an aim towards improving existing numerical methods for solving the problem. There are essentially two methods in circulation for solving the general 3-D coupled electrostatic-mechanical system: the relaxation method and Aluru and Whites’s multi-level Newton method. The former is simpler to implement (it is simply a fixed-point mapping) but suffers from the problem that convergence is slow near the pull-in voltage of a device. The second is significantly more difficult to implement but does not have the convergence problem near pull-in. Tanner has shown that the mathematical model has a “fold” in its solution space and that this fold is what causes the convergence problem in the relaxation method. Several methods developed by Dr. Herbert Keller (also
at Caltech applied mathematics) are known to be effective in dealing with this type of problem and are currently investigating their use in the Tanner model. Tanner expects the results of this investigation to be published in a refereed engineering journal.

1.4.4. Results Rendering

**Highlights for this quarter:**
- Developed capability for rendering of finite element and boundary element results, and integrated into L-Edit/3D modeling system.

Tanner has developed a finite element/boundary element results prototype rendering module, and integrated this with the L-Edit layout editor and 3D modeling system, bringing full windows functionality to this interface. The rendering supports multiple views, and integration with L-Edit allows the layout, solid model, and results to be managed and viewed all within the single application. Functionality includes panning, zooming, rotation, as well as several postprocessing functions such as calculation and visualization of the three principal stresses ($\sigma_1$, $\sigma_2$, $\sigma_3$), Octahedral Shear Stress and Von Mises Stress. In addition, the user can probe the display with the mouse pointer, and obtain detailed numerical data at the probed location.

![Figure 19: Integrated Layout, Solid Model, and Analysis Results.](image)

1.5. Model Builder

This Task comprises the development of a system that manages and partially automates the development of behavioral models from FE/BE analysis.

**Highlights for this quarter:**
1.5.1. Model Builder Architecture

The popular approach to model building so far has been to transform a finite/boundary element based model description to some reduced order model that is suitable for simulation with a differential equation type behavioral simulator, like SPICE, MATLAB or a VHDL-AMS simulator. Tanner feels that the Model Builder architecture should be sufficiently general to encompass reducing/transforming models from a variety of forms. The architecture will support for example, running simulations using a detailed behavioral model and transforming it to a simpler one for a different target behavioral simulator. An example from the VLSI realm is running a SPICE simulation to get a transient analysis waveform and deriving a simpler timing model. For this type of analysis, the model builder cannot make the apriori assumption that it is controlling a suite of finite element tools, but rather must think of controlling a group of simulators, transforming/reducing their output and building an output model. This approach does complicate the design flow, as there are multiple paths through the system, which make the software coding challenging. Although it is not within the scope of this effort to produce a model builder that works with all types of models and simulators, it was important to remove any bias towards having the system only work with finite element simulators. Tanner software support the following input engines- T-Spice, L-Edit/Extract, several FE/BE simulators, and user defined experimental data. In the future, Tanner hopes to support several behavioral input engines (VHDL-AMS type and MATLAB) as well as full-wave solvers. These simulators will be used as Model Builder outputs in the first release.

1.5.2. Model Builder Algorithms

There have been many model building algorithms proposed in the MEMS community, however, there has been no single algorithm that will work for all models, energy domains and simulators. Some algorithms may produce models that are useful for static but not dynamic analysis. So a big part of using these algorithms in Model Builder is to inform the user of their limitations and present each algorithm as appropriate to the user’s device. Tanner has taken the approach for the first version of model builder of giving the user a choice of algorithms. Future versions will add more choices.

For the first version several techniques are under consideration. The first is a straightforward, data collection mode leading to a table based model of the device.
Tanner made sure that the proposed model building architecture allowed us to describe the table to be created, implement setting up the various simulators for the analysis, collecting data from them, and generating the output tables. MATLAB implementations will follow. The next section describes a macromodel building example of a torsional resonator. A macromodel of the device for T-Spice using table controlled sources along with subcircuit models is built, and a set of finite element runs is performed using ANSYS to develop the tables for the T-Spice model.

Another approach is to use model reduction techniques of the PVL-Pade Via Lanczos type, as reported in the previous quarter. Tanner has some experience with these types of networks through work on coupling finite element thermal solvers with behavioral electronics simulators. Tanner has prototyped this type of algorithm in the thermal domain. The goal in implementing this algorithm is to put in place the mechanism where the actual reduction code can be modularized, so that as new techniques are available the code can easily be replaced. The first implementation will be a conservative one, where the user is restricted to using it in its region of accuracy and stability.

The third technique is to offer prewritten model building routines. One popular model is the capacitance/force calculation for structures such as comb drives. Another is to characterize the spring constant of various springs. Tanner has prototyped these algorithms and previously published this work in MSM 98.

1.5.3. Model Builder Example -- Generating a T-Spice Macromodel of an Accelerometer Using IMSET and ANSYS

1.5.3.1. Introduction

A T-Spice macromodel of an accelerometer is generated using design of experiments for finite-element analysis (FEA). The IMSET option of the IOPT\(^1\) tool is used to design the optimal experiments to perform ANSYS analysis at to compute the best estimate of model coefficients. This exercise is based on the work of Y. Gianchandani and S. Cray.\(^2\)

The accelerometer is composed of a rigid proof mass supported by four L-shaped beams. The accelerometer's response, the deflection in the \(z\) direction, is modeled as a function of two structural and three environmental parameters. These are the point of attachment of the support beam to the proof mass \((a)\), the width of the short segment of the support beam \((b)\), input axis acceleration \((a_i)\), cross axis acceleration \((a_c)\), and temperature \((T)\).

---


1.5.3.2. Procedure for Macromodel Generation

The following steps were taken to generate the macromodel:
1. Choose structural variables, environmental variables and ranges, model function
2. Design the experiment by running IMSET
3. Create table of values for layout generator
4. Generate layout of the accelerometers
5. Generate and export 3D models of the accelerometers
6. Run ANSYS analysis and store results
7. Run IMSET analysis to find the model coefficients
8. Create T-Spice model

1.5.3.3. Set Up

All structural dimensions are fixed except two, $a$ and $b$. These are listed in Table 1. The design variables and their ranges are listed in Table 2. The response of interest is the displacement in the $z$ direction at the center of the top face of the proof mass. It is hypothesized to be a second-order function of $a$ and $b$ and linear in acceleration and temperature. The model equation is shown in Equation 1.

<table>
<thead>
<tr>
<th>L1 [$\mu m$]</th>
<th>1000</th>
<th>Length of the proof mass.</th>
</tr>
</thead>
<tbody>
<tr>
<td>W1 [$\mu m$]</td>
<td>1000</td>
<td>Width of the proof mass.</td>
</tr>
<tr>
<td>H1 [$\mu m$]</td>
<td>500</td>
<td>Height of the proof mass.</td>
</tr>
<tr>
<td>L2 [$\mu m$]</td>
<td>1000</td>
<td>Length of the long segment of the support beam.</td>
</tr>
<tr>
<td>W2 [$\mu m$]</td>
<td>50</td>
<td>Width of the long segment of the support beam.</td>
</tr>
<tr>
<td>H2 [$\mu m$]</td>
<td>10</td>
<td>Height of the support beam.</td>
</tr>
<tr>
<td>L3 [$\mu m$]</td>
<td>60</td>
<td>Length of the short segment of the support beam</td>
</tr>
</tbody>
</table>

Table 1. Fixed Structural Dimensions and their Values

<table>
<thead>
<tr>
<th>a [$\mu m$]</th>
<th>100 - 900</th>
<th>Structural variable representing the point of attachment of the support beam to the proof mass.</th>
</tr>
</thead>
<tbody>
<tr>
<td>b [$\mu m$]</td>
<td>20 - 100</td>
<td>Structural variable representing the width of the short segment of the support beam.</td>
</tr>
</tbody>
</table>

24
<table>
<thead>
<tr>
<th>$a_z$ [m/s²]</th>
<th>0 - 100</th>
<th>Environmental variable representing the acceleration in the input, z, direction.</th>
</tr>
</thead>
<tbody>
<tr>
<td>$a_x$ [m/s²]</td>
<td>1 - 100</td>
<td>Environmental variable representing the acceleration in the cross axis, x, direction.</td>
</tr>
<tr>
<td>T [°C]</td>
<td>-100 - +100</td>
<td>Environmental variable representing the temperature.</td>
</tr>
</tbody>
</table>

Table 2. Design Variables and their Ranges

$$Z = \beta_0 + \beta_1a + \beta_2b + \beta_3a_x + \beta_4a_z + \beta_5a^2 + \beta_6a^3$$
$$+ \beta_7a^2b + \beta_8ab + \beta_9a_x + \beta_{10}a_z + \beta_{11}aT + \beta_{12}a_xT$$
$$+ \beta_{13}a_x^2 + \beta_{14}a_zT + \beta_{15}a_xa_z + \beta_{16}a_xT + \beta_{17}a_zT$$
$$+ \beta_{18}T + \beta_{19}a_x + \beta_{20}a_z + \beta_{21}a_xa_z + \beta_{22}a_xT$$
$$+ \beta_{23}a_zT + \beta_{24}a_xa_z + \beta_{25}a_xT + \beta_{26}a_zT$$
$$+ \beta_{27}a_xa_z + \beta_{28}a_xT + \beta_{29}a_zT + \beta_{30}a_xa_z + \beta_{31}a_xT$$
$$+ \beta_{32}a_zT + \beta_{33}a_xa_z + Z(a,b,m,s,T)$$

Equation 1. Model Function

1.5.3.4. Designing the Experiments

Since the model function (Equation 1) has 34 terms, the minimum number of points required to determine the coefficients is 34. 38 points were chosen to get a better estimate of the coefficients. IMSET was run to generate 38 experiment points for the model function. These points are listed in the table below.

<table>
<thead>
<tr>
<th>Point Number</th>
<th>A</th>
<th>b</th>
<th>ax</th>
<th>az</th>
<th>T</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>500.00</td>
<td>60.00</td>
<td>84.912</td>
<td>15.088</td>
<td>-69.824</td>
</tr>
<tr>
<td>2</td>
<td>180.277</td>
<td>27.463</td>
<td>79.801</td>
<td>79.801</td>
<td>59.602</td>
</tr>
<tr>
<td>3</td>
<td>504.971</td>
<td>25.973</td>
<td>83.419</td>
<td>83.419</td>
<td>-66.837</td>
</tr>
<tr>
<td>4</td>
<td>819.723</td>
<td>92.537</td>
<td>79.801</td>
<td>20.199</td>
<td>-59.602</td>
</tr>
<tr>
<td>5</td>
<td>180.277</td>
<td>27.463</td>
<td>20.199</td>
<td>20.199</td>
<td>59.602</td>
</tr>
<tr>
<td>6</td>
<td>495.029</td>
<td>94.027</td>
<td>83.418</td>
<td>16.581</td>
<td>66.837</td>
</tr>
<tr>
<td>7</td>
<td>504.972</td>
<td>25.973</td>
<td>16.582</td>
<td>16.582</td>
<td>-66.837</td>
</tr>
<tr>
<td>8</td>
<td>495.029</td>
<td>94.027</td>
<td>16.582</td>
<td>16.582</td>
<td>-66.837</td>
</tr>
<tr>
<td>9</td>
<td>824.522</td>
<td>27.921</td>
<td>20.184</td>
<td>20.184</td>
<td>59.631</td>
</tr>
<tr>
<td>10</td>
<td>824.522</td>
<td>27.921</td>
<td>79.816</td>
<td>20.184</td>
<td>-59.632</td>
</tr>
<tr>
<td>11</td>
<td>819.723</td>
<td>92.537</td>
<td>20.199</td>
<td>79.801</td>
<td>-59.602</td>
</tr>
<tr>
<td>12</td>
<td>180.277</td>
<td>27.463</td>
<td>20.199</td>
<td>79.801</td>
<td>-59.602</td>
</tr>
<tr>
<td>13</td>
<td>839.689</td>
<td>60.491</td>
<td>17.985</td>
<td>17.985</td>
<td>-64.030</td>
</tr>
<tr>
<td>14</td>
<td>175.478</td>
<td>92.079</td>
<td>20.184</td>
<td>79.816</td>
<td>-59.631</td>
</tr>
<tr>
<td>15</td>
<td>175.478</td>
<td>92.079</td>
<td>20.184</td>
<td>20.184</td>
<td>59.632</td>
</tr>
<tr>
<td>16</td>
<td>500.000</td>
<td>60.000</td>
<td>15.088</td>
<td>84.912</td>
<td>-69.824</td>
</tr>
<tr>
<td>17</td>
<td>839.689</td>
<td>60.491</td>
<td>82.015</td>
<td>82.015</td>
<td>-64.030</td>
</tr>
<tr>
<td>18</td>
<td>175.478</td>
<td>92.079</td>
<td>79.816</td>
<td>20.184</td>
<td>-59.631</td>
</tr>
<tr>
<td>19</td>
<td>160.311</td>
<td>59.509</td>
<td>17.985</td>
<td>82.015</td>
<td>64.030</td>
</tr>
<tr>
<td>20</td>
<td>495.029</td>
<td>94.027</td>
<td>83.418</td>
<td>83.418</td>
<td>-66.837</td>
</tr>
<tr>
<td>21</td>
<td>180.277</td>
<td>27.463</td>
<td>79.801</td>
<td>20.199</td>
<td>-59.602</td>
</tr>
<tr>
<td>22</td>
<td>839.689</td>
<td>60.491</td>
<td>17.985</td>
<td>82.015</td>
<td>64.030</td>
</tr>
<tr>
<td>23</td>
<td>824.522</td>
<td>27.921</td>
<td>79.816</td>
<td>79.816</td>
<td>59.631</td>
</tr>
<tr>
<td>24</td>
<td>839.689</td>
<td>60.491</td>
<td>82.015</td>
<td>17.985</td>
<td>64.030</td>
</tr>
<tr>
<td>25</td>
<td>496.188</td>
<td>78.752</td>
<td>50.000</td>
<td>50.000</td>
<td>0.000</td>
</tr>
<tr>
<td>26</td>
<td>504.971</td>
<td>25.973</td>
<td>83.419</td>
<td>16.582</td>
<td>66.837</td>
</tr>
<tr>
<td>27</td>
<td>819.723</td>
<td>92.537</td>
<td>20.199</td>
<td>20.199</td>
<td>59.602</td>
</tr>
<tr>
<td>28</td>
<td>160.311</td>
<td>59.509</td>
<td>17.985</td>
<td>17.985</td>
<td>-64.030</td>
</tr>
<tr>
<td>29</td>
<td>160.311</td>
<td>59.510</td>
<td>82.015</td>
<td>82.015</td>
<td>-64.030</td>
</tr>
<tr>
<td>30</td>
<td>175.478</td>
<td>92.079</td>
<td>79.816</td>
<td>79.816</td>
<td>59.632</td>
</tr>
<tr>
<td>31</td>
<td>503.811</td>
<td>41.248</td>
<td>50.000</td>
<td>50.000</td>
<td>0.000</td>
</tr>
<tr>
<td>32</td>
<td>500.000</td>
<td>60.000</td>
<td>15.088</td>
<td>15.088</td>
<td>69.824</td>
</tr>
<tr>
<td>33</td>
<td>824.522</td>
<td>27.921</td>
<td>20.184</td>
<td>79.816</td>
<td>-59.632</td>
</tr>
</tbody>
</table>
Table 3. Experiment Points

1.5.3.5. Creating the Table of Values for Layout Generation

The geometric parameters \((a\) and \(b)\) required by the layout generator were extracted and saved as a text file in a format that is recognized by the layout generator macro. The contents of the data file (accel.dat) is shown below.

<table>
<thead>
<tr>
<th>a (um)</th>
<th>b (um)</th>
<th>Cell Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>500</td>
<td>60</td>
<td>N1_A500_B60</td>
</tr>
<tr>
<td>180</td>
<td>27</td>
<td>N2_A180_B27</td>
</tr>
<tr>
<td>505</td>
<td>26</td>
<td>N3_A505_B26</td>
</tr>
<tr>
<td>820</td>
<td>93</td>
<td>N4_A820_B93</td>
</tr>
<tr>
<td>180</td>
<td>27</td>
<td>N5_A180_B27</td>
</tr>
<tr>
<td>495</td>
<td>94</td>
<td>N6_A495_B94</td>
</tr>
<tr>
<td>505</td>
<td>26</td>
<td>N7_A505_B26</td>
</tr>
<tr>
<td>495</td>
<td>94</td>
<td>N8_A495_B94</td>
</tr>
<tr>
<td>825</td>
<td>28</td>
<td>N9_A825_B28</td>
</tr>
<tr>
<td>825</td>
<td>28</td>
<td>N10_A825_B28</td>
</tr>
<tr>
<td>820</td>
<td>93</td>
<td>N11_A820_B93</td>
</tr>
<tr>
<td>180</td>
<td>27</td>
<td>N12_A180_B27</td>
</tr>
<tr>
<td>840</td>
<td>60</td>
<td>N13_A840_B60</td>
</tr>
<tr>
<td>175</td>
<td>92</td>
<td>N14_A175_B92</td>
</tr>
<tr>
<td>175</td>
<td>92</td>
<td>N15_A175_B92</td>
</tr>
<tr>
<td>500</td>
<td>60</td>
<td>N16_A500_B60</td>
</tr>
<tr>
<td>840</td>
<td>60</td>
<td>N17_A840_B60</td>
</tr>
<tr>
<td>175</td>
<td>92</td>
<td>N18_A175_B92</td>
</tr>
<tr>
<td>160</td>
<td>60</td>
<td>N19_A160_B60</td>
</tr>
<tr>
<td>495</td>
<td>94</td>
<td>N20_A495_B94</td>
</tr>
<tr>
<td>180</td>
<td>27</td>
<td>N21_A180_B27</td>
</tr>
<tr>
<td>840</td>
<td>60</td>
<td>N22_A840_B60</td>
</tr>
<tr>
<td>825</td>
<td>28</td>
<td>N23_A825_B28</td>
</tr>
<tr>
<td>840</td>
<td>60</td>
<td>N24_A840_B60</td>
</tr>
<tr>
<td>496</td>
<td>79</td>
<td>N25_A496_B79</td>
</tr>
<tr>
<td>505</td>
<td>26</td>
<td>N26_A505_B26</td>
</tr>
<tr>
<td>820</td>
<td>93</td>
<td>N27_A820_B93</td>
</tr>
<tr>
<td>160</td>
<td>60</td>
<td>N28_A160_B60</td>
</tr>
<tr>
<td>160</td>
<td>60</td>
<td>N29_A160_B60</td>
</tr>
<tr>
<td>175</td>
<td>92</td>
<td>N30_A175_B92</td>
</tr>
<tr>
<td>504</td>
<td>41</td>
<td>N31_A504_B41</td>
</tr>
<tr>
<td>500</td>
<td>60</td>
<td>N32_A500_B60</td>
</tr>
<tr>
<td>825</td>
<td>28</td>
<td>N33_A825_B28</td>
</tr>
<tr>
<td>495</td>
<td>94</td>
<td>N34_A495_B94</td>
</tr>
<tr>
<td>500</td>
<td>60</td>
<td>N35_A500_B60</td>
</tr>
<tr>
<td>820</td>
<td>93</td>
<td>N36_A820_B93</td>
</tr>
<tr>
<td>160</td>
<td>60</td>
<td>N37_A160_B60</td>
</tr>
<tr>
<td>505</td>
<td>26</td>
<td>N38_A505_B26</td>
</tr>
</tbody>
</table>

Table 4. Parameter Values for Layout Generator
1.5.3.6. Generating the Accelerometer Layout

The layout generator for the accelerometer is an L-Edit/UPI macro. This section describes how to load the macro into L-Edit, specify the input parameters, and launch the layout generation.

Loading the Macro

☑ Launch L-Edit.
☑ Choose File > New from the menu bar.
☑ Choose Tools > Macro from the menu bar.
☑ Click Add and open the file accel.dll.

Running the Macro

☑ Choose Tools > Generate Accelerometer. The Accelerometer Parameters dialog will appear.

![Accelerometer Parameters Dialog](image)

Figure 21. Accelerometer Parameters Dialog

User Interface

There are two ways of launching layout generation. The first is by entering the parameters into the edit fields and then clicking the OK button. The second is by clicking the Generate From Input File button and then choosing the file containing the list of parameters.

Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a (µm)</td>
<td>100</td>
<td>Location of attachment of the FLEX BEAM.</td>
</tr>
<tr>
<td>b (µm)</td>
<td>20</td>
<td>Width of the attachment of the FLEX BEAM to the PROOF MASS.</td>
</tr>
<tr>
<td>Cell Name</td>
<td></td>
<td>Name of cell to generate the layout into. If this field is filled in, a new cell is created and the accelerometer is generated into that new cell. If this field is left blank, the layout is generated into the current active cell. If this cell exists, layout generation</td>
</tr>
</tbody>
</table>
is aborted.

Controls

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Launches layout generation using the input values in the edit fields for \textit{a}, \textit{b}, and \textit{Cell Name}.</td>
</tr>
<tr>
<td>Generate From Input File</td>
<td>Requests input file. The format of the file is described in the next section on Input File Format.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancel layout generation.</td>
</tr>
</tbody>
</table>

Input File Format

The format of the input file is described here. The input files are ASCII text files containing columns of values for \textit{a}, \textit{b}, and \textit{Cell Name}. Each set of input parameter values is separated by a new line character and each parameter value is separated by white space (spaces, tabs). For example:

\begin{verbatim}
500 60  N1_A500_B60
180 27  N2_A180_B27
505 26  N3_A505_B26
\ldots
\end{verbatim}

Tutorial

\textit{Getting Started}

\checkmark Launch L-Edit.
\checkmark Choose \textit{File > New} from the menu bar.
\checkmark Choose \textit{Tools > Macro} from the menu bar.
\checkmark Click \textit{Add} and open the file \textit{accel.dll}.

\textit{Generating Based on Parameter Values Entered into the Edit Fields}

\checkmark Choose \textit{Tools > Generate Accelerometer}. The \textit{Accelerometer Parameters} dialog will appear.
\checkmark Accept the default values for \textit{a}, \textit{b}, and \textit{Cell Name} and click \textit{OK} to generate the layout.
Figure 22. Generated Layout for Default Values of $a$ and $b$

Generating Based on Parameter Values Input File

- Choose Tools > Generate Accelerometer. The Accelerometer Parameters dialog will appear.
- Click Generate From Input File and choose the file demo.dat. This file contains the following information:

<table>
<thead>
<tr>
<th>Value</th>
<th>Angle</th>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>500</td>
<td>60</td>
<td>N1_A500_B60</td>
</tr>
<tr>
<td>180</td>
<td>27</td>
<td>N2_A180_B27</td>
</tr>
<tr>
<td>505</td>
<td>26</td>
<td>N3_A505_B26</td>
</tr>
<tr>
<td>820</td>
<td>93</td>
<td>N4_A820_B93</td>
</tr>
<tr>
<td>180</td>
<td>27</td>
<td>N5_A180_B27</td>
</tr>
<tr>
<td>495</td>
<td>94</td>
<td>N6_A495_B94</td>
</tr>
</tbody>
</table>

Each layout will open in its specified cell. The following is a tiled view of the generated layout.

Figure 23. Generated Layout using demo.dat
1.5.3.7. Layout Generated for IMSET Values

For this exercise, 38 accelerometers are generated using the parameter values generated by IMSET. The parameter values are listed in a table in Table 4 and the file accel.dat. The generated accelerometers are shown in the figure below and in the file accel.tdb:

![Generated Layout using accel.dat](image)

**Figure 24. Generated Layout using accel.dat**

1.5.3.8. Generating and Exporting 3D Models from Layout

For each accelerometer, a 3D Model was generated and exported.

- With a layout window active, choose **Tools > 3D Tools > View 3D Model**. The 3D Model of the active cell will be created and displayed.
With a 3D Model window active, choose **Tools > Export 3D Model**. Set the **File name** and click **Export**.

### 1.5.3.9. Running ANSYS and Storing Results

For each experiment, an ANSYS structural analysis was performed to discover the z displacement of the center of the top face of the proof mass. These results are tabulated below.

<table>
<thead>
<tr>
<th>Point Number</th>
<th>A</th>
<th>b</th>
<th>ax</th>
<th>az</th>
<th>T</th>
<th>Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>500.000</td>
<td>60.000</td>
<td>84.912</td>
<td>15.088</td>
<td>-69.824</td>
<td>-0.4223843</td>
</tr>
<tr>
<td>2</td>
<td>180.277</td>
<td>27.463</td>
<td>79.801</td>
<td>79.801</td>
<td>59.602</td>
<td>-2.547131</td>
</tr>
<tr>
<td>3</td>
<td>504.971</td>
<td>25.973</td>
<td>83.419</td>
<td>83.419</td>
<td>-66.837</td>
<td>-2.664212</td>
</tr>
<tr>
<td>4</td>
<td>819.723</td>
<td>92.537</td>
<td>79.801</td>
<td>20.199</td>
<td>-59.602</td>
<td>-0.5045537</td>
</tr>
<tr>
<td>5</td>
<td>180.277</td>
<td>27.463</td>
<td>20.199</td>
<td>20.199</td>
<td>59.602</td>
<td>-0.6447884</td>
</tr>
<tr>
<td>6</td>
<td>495.029</td>
<td>94.027</td>
<td>83.418</td>
<td>16.581</td>
<td>66.837</td>
<td>-0.4121259</td>
</tr>
<tr>
<td>7</td>
<td>504.972</td>
<td>25.973</td>
<td>16.582</td>
<td>16.581</td>
<td>-66.837</td>
<td>-0.5335132</td>
</tr>
<tr>
<td>8</td>
<td>495.029</td>
<td>94.027</td>
<td>16.582</td>
<td>16.582</td>
<td>-66.837</td>
<td>-0.4120998</td>
</tr>
<tr>
<td>9</td>
<td>824.522</td>
<td>27.921</td>
<td>20.184</td>
<td>20.184</td>
<td>59.631</td>
<td>-0.6427243</td>
</tr>
<tr>
<td>10</td>
<td>824.522</td>
<td>27.921</td>
<td>79.816</td>
<td>20.184</td>
<td>-59.632</td>
<td>-0.6426650</td>
</tr>
<tr>
<td>11</td>
<td>819.723</td>
<td>92.537</td>
<td>20.199</td>
<td>79.801</td>
<td>-59.602</td>
<td>-1.993372</td>
</tr>
<tr>
<td>12</td>
<td>180.277</td>
<td>27.463</td>
<td>20.199</td>
<td>79.801</td>
<td>-59.602</td>
<td>-2.546955</td>
</tr>
<tr>
<td>13</td>
<td>839.689</td>
<td>60.491</td>
<td>17.985</td>
<td>17.985</td>
<td>-64.030</td>
<td>-0.5027006</td>
</tr>
<tr>
<td>14</td>
<td>175.478</td>
<td>92.079</td>
<td>20.184</td>
<td>79.816</td>
<td>-59.631</td>
<td>-1.996822</td>
</tr>
<tr>
<td>15</td>
<td>175.478</td>
<td>92.079</td>
<td>20.184</td>
<td>20.184</td>
<td>59.632</td>
<td>-0.5050112</td>
</tr>
<tr>
<td>16</td>
<td>500.000</td>
<td>60.000</td>
<td>15.088</td>
<td>84.912</td>
<td>-69.824</td>
<td>-2.377215</td>
</tr>
<tr>
<td>17</td>
<td>839.689</td>
<td>60.491</td>
<td>82.015</td>
<td>82.015</td>
<td>-64.030</td>
<td>-2.292463</td>
</tr>
<tr>
<td>18</td>
<td>175.478</td>
<td>92.079</td>
<td>79.816</td>
<td>20.184</td>
<td>-59.631</td>
<td>-0.5049537</td>
</tr>
<tr>
<td>19</td>
<td>160.311</td>
<td>59.509</td>
<td>17.985</td>
<td>82.015</td>
<td>64.030</td>
<td>-2.300195</td>
</tr>
<tr>
<td>20</td>
<td>495.029</td>
<td>94.027</td>
<td>83.418</td>
<td>83.418</td>
<td>-66.837</td>
<td>-2.073253</td>
</tr>
<tr>
<td>21</td>
<td>180.277</td>
<td>27.463</td>
<td>79.801</td>
<td>20.199</td>
<td>-59.602</td>
<td>-0.6446122</td>
</tr>
<tr>
<td>22</td>
<td>839.689</td>
<td>60.491</td>
<td>17.985</td>
<td>82.015</td>
<td>64.030</td>
<td>-2.292494</td>
</tr>
<tr>
<td>23</td>
<td>824.522</td>
<td>27.921</td>
<td>79.816</td>
<td>79.816</td>
<td>59.631</td>
<td>-2.541435</td>
</tr>
</tbody>
</table>

31
### Table 5. ANSYS Results for the Experiments

#### 1.5.3.10. Running IMSET Analysis to Find Model Coefficients

<table>
<thead>
<tr>
<th>Coeff. $\beta_i$</th>
<th>Term</th>
<th>IMSET fit for $\beta_i$</th>
<th>Coeff. $\gamma_i$</th>
<th>Term</th>
<th>IMSET fit for $\gamma_i$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\beta_0$</td>
<td>-</td>
<td>[\text{Exp}(-a-a^{(1)})^2-(b-b^{(1)})^2-(c-c^{(1)})^2-(d-d^{(1)})^2-(e-e^{(1)})^2-(T-T^{(1)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_1$</td>
<td>a</td>
<td>[\text{Exp}(-a-a^{(2)})^2-(b-b^{(2)})^2-(c-c^{(2)})^2-(d-d^{(2)})^2-(e-e^{(2)})^2-(T-T^{(2)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_2$</td>
<td>b</td>
<td>[\text{Exp}(-a-a^{(3)})^2-(b-b^{(3)})^2-(c-c^{(3)})^2-(d-d^{(3)})^2-(e-e^{(3)})^2-(T-T^{(3)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_3$</td>
<td>a$_x$</td>
<td>[\text{Exp}(-a-a^{(4)})^2-(b-b^{(4)})^2-(c-c^{(4)})^2-(d-d^{(4)})^2-(e-e^{(4)})^2-(T-T^{(4)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_4$</td>
<td>a$_y$</td>
<td>[\text{Exp}(-a-a^{(5)})^2-(b-b^{(5)})^2-(c-c^{(5)})^2-(d-d^{(5)})^2-(e-e^{(5)})^2-(T-T^{(5)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_5$</td>
<td>T</td>
<td>[\text{Exp}(-a-a^{(6)})^2-(b-b^{(6)})^2-(c-c^{(6)})^2-(d-d^{(6)})^2-(e-e^{(6)})^2-(T-T^{(6)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_6$</td>
<td>a$^2$</td>
<td>[\text{Exp}(-a-a^{(7)})^2-(b-b^{(7)})^2-(c-c^{(7)})^2-(d-d^{(7)})^2-(e-e^{(7)})^2-(T-T^{(7)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_7$</td>
<td>b$^2$</td>
<td>[\text{Exp}(-a-a^{(8)})^2-(b-b^{(8)})^2-(c-c^{(8)})^2-(d-d^{(8)})^2-(e-e^{(8)})^2-(T-T^{(8)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_8$</td>
<td>a b</td>
<td>[\text{Exp}(-a-a^{(9)})^2-(b-b^{(9)})^2-(c-c^{(9)})^2-(d-d^{(9)})^2-(e-e^{(9)})^2-(T-T^{(9)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_9$</td>
<td>a a$_x$</td>
<td>[\text{Exp}(-a-a^{(10)})^2-(b-b^{(10)})^2-(c-c^{(10)})^2-(d-d^{(10)})^2-(e-e^{(10)})^2-(T-T^{(10)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_10$</td>
<td>a a$_y$</td>
<td>[\text{Exp}(-a-a^{(11)})^2-(b-b^{(11)})^2-(c-c^{(11)})^2-(d-d^{(11)})^2-(e-e^{(11)})^2-(T-T^{(11)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_11$</td>
<td>a T</td>
<td>[\text{Exp}(-a-a^{(12)})^2-(b-b^{(12)})^2-(c-c^{(12)})^2-(d-d^{(12)})^2-(e-e^{(12)})^2-(T-T^{(12)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_12$</td>
<td>b a$_x$</td>
<td>[\text{Exp}(-a-a^{(13)})^2-(b-b^{(13)})^2-(c-c^{(13)})^2-(d-d^{(13)})^2-(e-e^{(13)})^2-(T-T^{(13)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_13$</td>
<td>b a$_y$</td>
<td>[\text{Exp}(-a-a^{(14)})^2-(b-b^{(14)})^2-(c-c^{(14)})^2-(d-d^{(14)})^2-(e-e^{(14)})^2-(T-T^{(14)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_14$</td>
<td>b T</td>
<td>[\text{Exp}(-a-a^{(15)})^2-(b-b^{(15)})^2-(c-c^{(15)})^2-(d-d^{(15)})^2-(e-e^{(15)})^2-(T-T^{(15)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_15$</td>
<td>a a$_x$ b</td>
<td>[\text{Exp}(-a-a^{(16)})^2-(b-b^{(16)})^2-(c-c^{(16)})^2-(d-d^{(16)})^2-(e-e^{(16)})^2-(T-T^{(16)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_16$</td>
<td>a a$_y$ T</td>
<td>[\text{Exp}(-a-a^{(17)})^2-(b-b^{(17)})^2-(c-c^{(17)})^2-(d-d^{(17)})^2-(e-e^{(17)})^2-(T-T^{(17)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_17$</td>
<td>a T</td>
<td>[\text{Exp}(-a-a^{(18)})^2-(b-b^{(18)})^2-(c-c^{(18)})^2-(d-d^{(18)})^2-(e-e^{(18)})^2-(T-T^{(18)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_18$</td>
<td>a a$_x$ a</td>
<td>[\text{Exp}(-a-a^{(19)})^2-(b-b^{(19)})^2-(c-c^{(19)})^2-(d-d^{(19)})^2-(e-e^{(19)})^2-(T-T^{(19)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_19$</td>
<td>a a$_y$ T</td>
<td>[\text{Exp}(-a-a^{(20)})^2-(b-b^{(20)})^2-(c-c^{(20)})^2-(d-d^{(20)})^2-(e-e^{(20)})^2-(T-T^{(20)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_20$</td>
<td>a a$_x$ T</td>
<td>[\text{Exp}(-a-a^{(21)})^2-(b-b^{(21)})^2-(c-c^{(21)})^2-(d-d^{(21)})^2-(e-e^{(21)})^2-(T-T^{(21)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_21$</td>
<td>a a$_y$ T</td>
<td>[\text{Exp}(-a-a^{(22)})^2-(b-b^{(22)})^2-(c-c^{(22)})^2-(d-d^{(22)})^2-(e-e^{(22)})^2-(T-T^{(22)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_22$</td>
<td>a a$_x$ T</td>
<td>[\text{Exp}(-a-a^{(23)})^2-(b-b^{(23)})^2-(c-c^{(23)})^2-(d-d^{(23)})^2-(e-e^{(23)})^2-(T-T^{(23)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_23$</td>
<td>a a$_y$ T</td>
<td>[\text{Exp}(-a-a^{(24)})^2-(b-b^{(24)})^2-(c-c^{(24)})^2-(d-d^{(24)})^2-(e-e^{(24)})^2-(T-T^{(24)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_24$</td>
<td>a a$_x$ T</td>
<td>[\text{Exp}(-a-a^{(25)})^2-(b-b^{(25)})^2-(c-c^{(25)})^2-(d-d^{(25)})^2-(e-e^{(25)})^2-(T-T^{(25)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_25$</td>
<td>a a$_y$ T</td>
<td>[\text{Exp}(-a-a^{(26)})^2-(b-b^{(26)})^2-(c-c^{(26)})^2-(d-d^{(26)})^2-(e-e^{(26)})^2-(T-T^{(26)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_26$</td>
<td>a a$_x$ T</td>
<td>[\text{Exp}(-a-a^{(27)})^2-(b-b^{(27)})^2-(c-c^{(27)})^2-(d-d^{(27)})^2-(e-e^{(27)})^2-(T-T^{(27)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_27$</td>
<td>a a$_y$ T</td>
<td>[\text{Exp}(-a-a^{(28)})^2-(b-b^{(28)})^2-(c-c^{(28)})^2-(d-d^{(28)})^2-(e-e^{(28)})^2-(T-T^{(28)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_28$</td>
<td>a a$_x$ T</td>
<td>[\text{Exp}(-a-a^{(29)})^2-(b-b^{(29)})^2-(c-c^{(29)})^2-(d-d^{(29)})^2-(e-e^{(29)})^2-(T-T^{(29)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$\beta_29$</td>
<td>a a$_y$ T</td>
<td>[\text{Exp}(-a-a^{(30)})^2-(b-b^{(30)})^2-(c-c^{(30)})^2-(d-d^{(30)})^2-(e-e^{(30)})^2-(T-T^{(30)})^2]</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

32
\begin{align*}
\beta_{30} & \quad b \ a_z \ a_x \\
\beta_{31} & \quad b \ a_z \ T \\
\beta_{32} & \quad b \ a_x \ T \\
\beta_{33} & \quad T \ a_z \ a_x \\
\gamma_{31} & \quad \exp(-\alpha-b^{-31})^2-(b-b^{-31})^2-(a_x-a_z^{-31})^2-(a_x-a_z^{-31})^2-(T-T^{-31})^2 \\
\gamma_{32} & \quad \exp(-\alpha-b^{-32})^2-(b-b^{-32})^2-(a_x-a_z^{-32})^2-(a_x-a_z^{-32})^2-(T-T^{-32})^2 \\
\gamma_{33} & \quad \exp(-\alpha-b^{-33})^2-(b-b^{-33})^2-(a_x-a_z^{-33})^2-(a_x-a_z^{-33})^2-(T-T^{-33})^2 \\
\gamma_{34} & \quad \exp(-\alpha-b^{-34})^2-(b-b^{-34})^2-(a_x-a_z^{-34})^2-(a_x-a_z^{-34})^2-(T-T^{-34})^2 \\
\gamma_{35} & \quad \exp(-\alpha-b^{-35})^2-(b-b^{-35})^2-(a_x-a_z^{-35})^2-(a_x-a_z^{-35})^2-(T-T^{-35})^2 \\
\gamma_{36} & \quad \exp(-\alpha-b^{-36})^2-(b-b^{-36})^2-(a_x-a_z^{-36})^2-(a_x-a_z^{-36})^2-(T-T^{-36})^2 \\
\gamma_{37} & \quad \exp(-\alpha-b^{-37})^2-(b-b^{-37})^2-(a_x-a_z^{-37})^2-(a_x-a_z^{-37})^2-(T-T^{-37})^2 \\
\gamma_{38} & \quad \exp(-\alpha-b^{-38})^2-(b-b^{-38})^2-(a_x-a_z^{-38})^2-(a_x-a_z^{-38})^2-(T-T^{-38})^2 \\
\end{align*}

Table 6. Coefficients for Model Equation

1.5.3.11. Creating the Macromodel

The macromodel for the accelerometer was implemented using S-Edit as the schematic front end. Shown below in

Figure 26 is the Symbol view of the accelerometer element. The structural parameters \(a\) and \(b\) and the coefficients of the model \(\beta_{30} - \beta_{33}\) are properties of the symbol. The environmental parameters \(a_x, a_z,\) and \(T\) are ports of the symbol. The voltages at these ports represent the accelerations in the \(z\) and \(x\) directions and the temperature. The \(z\) displacement is modeled using an expression voltage controlled voltage source (the \(E\) element).

A very simple circuit was constructed to test this macromodel. The test circuit shown in Figure 27 performs a DC sweep of the acceleration in the \(z\) direction, \(a_z\). As expected, the plot of \(Z\) vs. \(a_z\) is linear.

Note that this macromodel only captures the mechanical behavior of the accelerometer. In a microaccelerometer system, the \(z\) displacement may be detected in a number of ways. If the detection method is capacitive, a \(z\) displacement controlled capacitor should be added to the macromodel. If the detection method is piezoresistive, a variable resistor should be added to the macromodel. etc. Measurement circuits must also be added to detect these values.
Figure 26. Schematic Symbol of the Accelerometer Macromodel

Figure 27. Test Circuit for the Accelerometer Macromodel
1.5.3.12. Future Work

The macromodel will be extended to include the electrical behavior as a function of the z displacement. The electrical behavior will be coupled to the mechanical model implemented in the section above through the Z port. Detection circuits will also be added to exercise this macromodel in an accelerometer system.

Each step along the path from device structure to macromodel generation was demonstrated here. While the instructions are simple, many of the steps were performed manually. Most of these steps will be automated to simplify and shorten the design cycle. Future work will include better integration and smoother flow of data between layout, picking of the factors and model equation, design of experiment, 3D model generation and export, finite element analysis, results gathering, calculating the model coefficients, and actual building of the macromodel.

1.6. Circuit Refinement Suite and Mixed-Language Macromodel Support

The tasks under this effort are directed at creating a system level simulation and analysis capability to complement the device level layout and analysis tools currently under development. Although an HDL-only approach is preferable for all-digital circuits, design entry for mixed-signal (analog/digital/RF) electronic circuits is best accomplished using a combined schematic/HDL approach. The same is true for mixed-technology microchips, where IM components are mixed with standard electronic circuits. The ability to perform design entry and simulation using a blend of components from various domains (electrical, mechanical, optical, fluidic, etc.) motivates the schematic, behavioral modeling, and simulation capabilities of this section. Tasks in this section include i) Schematic Tool Multi-domain IM Enhancements, ii) Thermal & Mechanical Behavioral Modeling Engines, iii) Mixed-Language Models, and iv) MATLAB Modeling capability.
1.6.1. Schematic Tool Multi-domain Enhancements

The goal of this task is to create a schematic capability with domain dependent typed signals with error checking, mixed domain busses, and multi-domain symbols display. This gives the Tanner design environment front-end tools the ability to manipulate mixed-domain schematics, with various signal types, and view simulated mixed-domain signals. The schematic editor will also be enhanced with support for test benches for controlling simulation that have domain specific stimuli and control parameters. Input forces, pressures or acceleration, tolerance settings for spatial variables are examples of stimuli requiring domain specific treatment.

Tanner’s approach to this task is to integrate the ViewDraw schematic editor into the MEMS-Pro tools suite, then to develop additional capabilities through the ViewDraw API. The ViewDraw schematic editor is able to handle very large designs, and many capabilities of interest to mixed technology designers are already present in the software, including busses and multidomain model manipulation. In addition, ViewDraw has a flexible API that allows us to implement additional MEMS features within the tool. The integration is proceeding in two phases, the first release provides file level communication between ViewDraw and T-Spice, component libraries in the ViewDraw format, and a translation capability to export designs from S-Edit into ViewDraw. The second phase implements a tight integration between ViewDraw, T-Spice, and W-Edit, providing the ability to invoke simulations from ViewDraw, and perform cross-probing of waveforms by clicking on nodes in the schematic.

Tanner has also worked on support of busses and complex numbers in T-Spice and W-Edit, and have investigated how busses will be supported in schematic, through the netlister, and into T-Spice.

1.6.1.1. Viewlogic Integration Implementation

Viewlogic Integration with Tanner Tools has been developed using two new features, the Tanner Toolbar and the Tanner Project Manager. The Tanner Project Manager assists the user in managing the files associated with a particular project, and allows the user to set the Tanner Working Directory (TWD). The aim of the project manager is to organize all the files associated with a particular design, and should evolve to provide indications to the user on where they are in the design cycle, and what operations need to be done. For example, it might indicate that layout have changed and verification needs to be redone. It also serves to synchronize the files associated with a design. The Tanner Toolbar allows a user to launch tools in the Tanner Tools Pro suite such that file open and
file save operations originate in the TWD. The Tanner Toolbar is intended to be a convenient location where users can access tools in the Tanner Tools Pro suite. Together, these tools will provide a user with a cleaner way to organize several projects. The Tanner Toolbar will be customizable. ViewDraw integration can be accomplished by putting Viewlogic items in the toolbar and replacing the Tanner Project Manager with the Workview Office Project manager.

User Interfaces

The Tanner Toolbar looks and acts much like toolbars in Windows applications. Each button has an icon associated with it. Clicking on a button launches the associated application. The first button brings up a popup menu instead of launching an application.

![Tanner Office Toolbar](image)

Figure 29: Tanner Toolbar

1.6.2. Mixed Language Models

The goal of this task is to develop a simulation management interface for manipulation of VHDL. VHDL-AMS, SPICE, data-table, “C”, and MATLAB oriented models. This interface provides the capability to combine simulations at different levels of abstraction required for final simulation of the entire design. Output of low level simulations in one type may be input into higher level simulations of a different type. The microsystem designer is able to perform top-down design optimization and bottom-up design verification using a variety of integrated simulation techniques and a mix of models described at various levels of abstraction. Tanner has achieved the ability to perform simulations of designs involving models in SPICE, data table, “C”, and MATLAB formats and expect to develop additional capability to interface to VHDL and VHDL-AMS simulators in the future.

1.6.3. Matlab Modeling and Mechanical and Thermal Behavioral Simulation

The goal of the Mechanical and Thermal Modeling task is to develop simulation technology capable of processing component models described in terms of the generalized multi-dimensional spring-mass-damper equilibrium equation, or for thermal analysis, in terms of Green’s function impulse responses. Tanner has determined that this simulation capability will be most appropriately implemented using the MATLAB interface. The goal of the MATLAB integration task is to develop a general purpose support for evaluating MathWork’s MATLAB$^\text{TM}$ format models from within the proposed CAD environment.

The foundational component of MATLAB, the high level programming language, is especially well suited for prototyping and testing complex mathematical equations for scientific and engineering applications. Additionally, MATLAB provides a wide variety of specialized algorithms and functions for specific application areas such as signal processing, image processing, wavelets, control systems, etc. The combination of the
MATLAB programming language, mathematical functions, and the application toolboxes provides a wealth of possibilities for developing mechanical, fluidic, thermal, optic, and other types of device models.

Tanner has implemented MATLAB model support, and are planning its release in T-Spice Version 6.5. In this release, the user will create MATLAB models, compile them as DLL’s, and then be able to execute them from T-Spice using the T-Spice external model interface. Tanner will create code templates for users, to assist in building the infrastructure code required for communication between the model and T-Spice. These device models may now be incorporated within T-Spice simulations via T-SPICE’s MATLAB interface.

1.6.3.1. The Procedure

The procedure for creating a Matlab model of a device, and interfacing the model with T-Spice is described below:

- Develop T-Spice model evaluation and derivative evaluation code using the MATLAB programming language.
- Write C code to convert the MATLAB function’s input and output data to/from standard C data types.
- Modify the T-Spice External Model Interface template (C source code) to call the data conversion and MATLAB model evaluation functions.
- Compile the MATLAB functions, Data Conversion code, and T-Spice External Model Interface code using MATLAB’s mcc compiler, creating a shared library.
- Modify the T-Spice input file (netlist) to include a definition of the new external model and one or more instances of the model.
- Run T-Spice and view the results with W-Edit.
1.7. Layout Synthesis and Verification

The tasks under this effort will deliver a suite of system level synthesis and verification tools to complement the device level analysis tools. These tools will bring the capability of IC synthesis and verification technology to the domain of the Integrated Microdevice (IM) designer, including Mixed Technology Block Place and Route, Multi-domain Layout Extraction, and Context Sensitive DRC.

1.7.1. Mixed Technology Place and Route

The goal of this task is to develop a Block Place and Route tool capable of placing and interconnecting individual or blocks of integrated microdevices, with a limited set of performance driven constraints. Core code development has also been completed and integrated into the L-Edit layout editor, and the tool has shipped in commercial release.

Highlights:

- Commercial release of Block Place and Route in the MEMS Pro V2 release.
- Demonstration of BPR capabilities using AFRL MEMS-Push design.
- Developed automatic and manual block placement and routing (BPR) capability with the following features:
  - Support of industry standard EDIF netlist format.
  - Incorporate IP blocks, custom blocks and standard cells into your design, perform basic floorplanning, and evaluate and control interconnect parameters, resulting in a more tightly integrated design.
  - Routed blocks may be hierarchically composed into higher levels of design. Blocks may consist of compositions from another BPR cycle, from SPR, from hand layout, or from a library.
  - At any time during the design process, easily place and route blocks or perform signal integrity and timing analysis to ensure adherence to performance requirements. Automatic and manual routing may be intermixed with the user-assisted routing feature.
  - Persistent connectivity information throughout layout operations.
  - Topology-driven automatic routing.
  - Built-in fast delay calculator.
  - On-line SPICE signal integrity analysis.
  - Integrated design environment based on unified physical, electrical, and timing information.
  - Block place and route integrated with Standard Cell Place and Route, Subcircuit Extraction, and Layout Editing.
  - Prototyped VHDL netlist support.

Development of the Block Place and Route tool came up to speed very quickly, and Tanner has been able to demonstrate manual and automatic placement as well as manual and automatic routing. The culmination of this effort was the shipping of the BPR module
in L-Edit V8 and MEMS-Pro V2. The features of the tool are listed in the above highlights section.

An example of a Q-controlled resonator has been developed and used to test the Block Place and Route tools. Input to the tool consists of a netlist, and a cell library containing the cells referenced in the netlist. Figure 31 below shows the layout of the Q-controlled resonator after the netlist has been read in and the cells have been instantiated in the design. Here the terms cells and blocks are used synonymously. The red lines connecting the cells is the rats nest. The rats nest shows connections using a minimum spanning tree, which connects the terminals of a net such that the length of the net routing is minimized.

Figure 32 shows the layout after the user has performed manual placement, using the rats nest as a guide to minimize congestion. Note that the connection lines stay connected and stretch as block are moved. Figure 33 shows the design after routing has been completed.

![Figure 31: Block Place and Route of Q-Controlled resonator, illustrating initial placement of cells. Red lines connecting cells are the rats nest.](image-url)
Figure 32: Block Place and Route of Q-Controlled resonator, illustrating manually placed design. Note rubberbanding of connections as block on lower left is moved.

Figure 33: Block Place and Route of Q-Controlled resonator, illustrating routed design.
A delay calculator based on the moment matching method has also been developed and integrated into BPR, for accurate calculation of RLC delay. Nets violating a delay criteria are easily identified. Interactive signal integrity analysis is also integrated into BPR via a convenient user interface to the T-Spice circuit simulator. User are be able to click on any net and quickly obtain results of a simulation be able to probe wave forms at specified test points.

In addition to core Place and Route development, Tanner has investigated support of VHDL netlists in the Block Place and route system. Currently netlist input is through tpr (Tanner Place and Route) and EDIF formats. A partial VHDL parser was developed, and placement and routing of a design was demonstrated, however this feature was not pushed all the way through to commercial release.

The AFRL MEMS-Push chip continues to be Tanner’s prime demonstration vehicle for mixed technology BPR applications. Tanner has used SPR to route the CPU, UART, and RTC cores, and used BPR to route the three cores together. Addition of the layout cell and connectivity for the MEMS device will complete the demonstration. Figure 34 shows the placement of the cores in BPR, with the purple lines showing connections between blocks prior to routing. Figure 35 shows the design with routing completed.

![Figure 34: AFRL MES-Push design, placed using BPR.](image-url)
1.7.2. Multidomain Layout Extraction

This task involves development and demonstration of a layout extractor capable of extracting mechanical, thermal, and other domain topologies.

**Highlights:**
- Developed capability to extract MEMS devices from layout. The features builds on a general purpose property tool to attach properties to any object in L-Edit.
- Developed a design of references and equation support for L-Edit properties in support of MEMS device extraction.

Tanner has developed a general purpose property mechanism for objects in L-Edit, and built upon this foundation to support of MEMS device extraction. Properties such as length, width, and number of comb drive fingers may be attached to a cell, as shown in Figure 36. Once properties have been defined on a cell or instance, the extract tool is able to detect these properties and write them into the Spice netlist during extraction. This capability is particularly useful in conjunction with automatic layout macros, as the properties may be coded into the macro, and assigned to the cell during layout generation.

The properties tool has been designed to handle hierarchical assignment of properties. A valuable capability of the inheritance mechanism is that it allows the user to change properties of all instances simply by changing properties of the parent cell, a feature not present in earlier designs of the tool. Cell properties may also be overridden on a particular instance. The Extract tool first inspects the instance for properties, and for any properties that are not found on the instance, Extract will search for on the cell. Instance properties are thus inherited from the cell.
Tanner has also investigated on how the properties based extract features can be further enhanced. Tanner has worked on designing a mechanism by which properties may reference other properties at any location in the design. Tanner is also designing a mechanism by which properties may contain equations, and these equations may in turn contain references to other properties. In particular, property references will provide the capability for cells to refer to properties on objects within the cell. Since MEMS devices are conveniently extracted as subcircuits, it is important for a cell to be able to communicate with its contents. The ability to reference properties in Extract will provide other unique capabilities. For example, the extractor could reference material properties and process steps in the 3D modeling tool, and calculate the mass of an object. The goal is to design a flexible structure that lets the user customize the configuration to his particular device.

1.7.3. Design Rule Checking

This task involves the development and demonstration of DRC enhancements enabling integrated MEMS/IC design verification, including: i) context sensitive DRC, ii) support of multiple rule sets, and iii) improvements to DRC core engine.

**Highlights:**
- Developed capability to support multiple rule sets, and apply different rule sets in different areas of the layout.
- Developed capability to automatically partition rules into groups to maximize performance.
- Continued to enhance the fundamental data structures and search engines in support of new curved primitives for MEMS structures.

Context sensitive DRC provides the ability for a set of rules to vary on-the-fly based on the geometry of the layout being verified. Examples of context sensitive DRC are to apply a different width rule to traces exceeding a critical length, or different rules to comb teeth above and below a specified length. Specifically, context sensitive DRC involves
the implementation of a selection feature defined as follows: Select polygons \( x \) from layer A based on relation with polygons in layer B: (1) \textit{inside}, \textit{outside}, \textit{hole}; (2) \textit{cut}, \textit{touch}, \textit{enclose} (with ranges); also selection based on labels, vertex count, number of distinct polygons to which \( x \) is related. This operation enables context sensitive DRC operations by filtering layout by a specified criteria before continuing processing, either rule checking or additional Boolean operations. Selection operations may be concatenated together. Development of the SELECT feature has been demonstrated, and is ongoing.

Tanner has developed and demonstrated selection operations that permit the construction of logical relations on layers, such as touching, cutting, containment, and edge adjacency. Based upon such relations, one can then select desired sets of objects; for example, one can isolate all objects on layer A that are contained within an object of layer B, or all objects on layer A that cut between two and four objects on layer B. The underlying architecture is sufficiently general to permit the addition of other criteria for the construction of such relations, such as ones dependent upon properties.

The DRC engine permits a second sort of selection - selection of edges based upon metric criteria such as width, length or spacing. As in the case of the logical selection operations, objects selected through DRC operations can then be the subject of successive DRC operations. For example, one may use this form of selection to segregate long and short wires, to which different sets of DRC rules should apply.

An example of All Angle DRC with Selection capability is illustrated in the figure below. On the left is shown a close up of the layout of a motor, with layer Poly 0 in green and layer Poly 1 in red. A ground plate is drawn on Poly 0, and the rotors and stators of the motor are drawn on Poly 1. On the right shown in green is the result of the boolean operation (Poly 0) AND (Poly 1). Also on the right shown outlined in white is the result of the selection operation (SELECT all polygons on Poly 1 that TOUCH TWO polygons on Poly 0). The two polygons on Layer Poly 0 are the ground plate and an additional pad that is out of the figure. This TOUCH rule is able to identify a short stator that has not extended long enough to touch the ground plate, and will thus not function.

\[ \text{Short Stator} \]

\[ \text{Figure 37: Illustration of all-angle Boolean and Selection operations for MEMS.} \]
Tanner has also developed the feature that enables the user to group rules into different rule sets, and apply those rule sets to different regions of the layout. The rule groups may represent MEMS and IC rules, to be applied separately in the MEMS and IC regions. Rule groups may also be used to apply rules selectively to a region of the MEMS device, as in the case of applying etch hole rules only a plate but not on beams and springs, as shown in Figure 38 to Figure 41 below.

Figure 38: Dialog boxes for multiple rule setup.

```
# COPYRIGHT (c) 1999 Tanner Research
#
<Group>
  <Name>MEMS rules</Name>
  <Enable>TRUE</Enable>
  <Layer>default</Layer>
  <BinSize>1000</BinSize>
  <Rules>
    <RuleName>A. Poly0 space to Anchor1 = 4u</RuleName> # grow = 4
    <RuleName>B. Poly0 enclose Anchor1 = 4u</RuleName> # grow = 4
    <RuleName>C. Poly0 enclose Poly1 = 4u</RuleName> # grow = 4
    <RuleName>D. Poly0 enclose Poly2 = 5u</RuleName> # grow = 5
    <RuleName>E. Poly0 enclose Anchor2 = 5u</RuleName> # grow = 5
    <RuleName>F. Poly0 space to Anchor2 = 5u</RuleName> # grow = 5
    ...
  </Rules>
</Group>
```
Table 7: Sample of multiple rule groups configuration file. First group is applied everywhere, second group for etch holes is applied only on plate.

Figure 39: Linear resonator with etch holes in the plate mass. Selectively check for density of etch holes only in plate area of poly1 layer, but not in comb or spring areas.
Lastly, Tanner has done additional work this quarter to bring curved drawing primitives back into the sweep algorithm for boolean operations and DRC.

1.8. Program Management

This task comprises the following activities: (1) technical and administrative management of the technical data and computer software produced as a result of all work
on the contract, and (2) administration of the contract deliverables, subcontracts and billings.

During this quarter Program Management duties have involved technical direction of the project, attendance and presentation at the Composite CAD PI Meeting in Agoura Hills, and writing of this Final Report.

1.9. Applications Engineering and Productization

This task has involved the development and collection of sample designs, and demonstration of the design process through the system, as well as the management of alpha-site and beta-site releases of the tools. Sample designs developed have been incorporated into tutorials and examples shipped with MEMS-Pro V2. An important aspect of this task is Tanner Research attendance at conferences, symposia, user-group meetings and training classes to identify potential customers, foundry partners and other collaborators. Tanner has actively attended and presented at MEMS industry conferences, and also taught MEMS design as part of the MCNC MUMPS training class.
2. Program Milestones

Tanner has shipped the commercial release of MEMS-Pro V2, which contains the new 3D Modeling module, MEMS libraries and technology setups, the new Block Place and Route module, MEMS Extraction capabilities as well as T-Spice features including the C programmable functional model interface. Also in this release is the ability to easily export 3D models from MEMS-Pro, and import them into ANSYS for FEA analysis.

Many of the capabilities prototyped and demonstrated in this program continue to be developed, and are scheduled to be released in the year 2000. This includes the DRC rule grouping and context sensitive checking features, ViewDraw integration and Schematic features, as well as MATLAB integration. The angled sidewall modeling and analysis features have been prototyped and demonstrated as described in this report. Also, Model Builder was demonstrated at the PI meeting in Agoura Hills, on an accelerometer example. This example, which was created in collaboration with Dr. Selden Crary from the University of Michigan, is also discussed in this report.

Tanner plans on delivering a commercial release of T-Spice Pro V6.5 by the end of Q2 2000, which is scheduled to contain the MATLAB interface, a Viewdraw front end into T-Spice simulation, implementation of the new e and g elements in T-Spice, improved waveform viewing for non-electrical signals, and optimization enhancements. The MATLAB modeling capability and Viewlogic integration have been prototyped, and are now in the commercial development phase.

<table>
<thead>
<tr>
<th>Physical Design</th>
<th>Date</th>
<th>Accomplished</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demo of Right Angle Solid Model &amp; Visualization</td>
<td>01-Oct-97</td>
<td>Yes</td>
</tr>
<tr>
<td>Demo of Layout and Simulation Libraries</td>
<td>01-Dec-97</td>
<td>Yes</td>
</tr>
<tr>
<td>Final Specification of Process Definition</td>
<td>01-Apr-98</td>
<td>Yes</td>
</tr>
<tr>
<td>Beta of Right Angle Solid Model &amp; Visualization w/G</td>
<td>01-Jul-98</td>
<td>Yes</td>
</tr>
<tr>
<td>Final spec of Library Structure</td>
<td>01-Jul-98</td>
<td>Yes</td>
</tr>
<tr>
<td>Demo of Libraries</td>
<td>01-Oct-98</td>
<td>Yes</td>
</tr>
<tr>
<td>Alpha of Angled Sidewall Solid Model</td>
<td>01-Jan-99</td>
<td>Yes</td>
</tr>
<tr>
<td>Beta of Angled Sidewall Solid Model</td>
<td>01-Jul-99</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Finite/Boundary Element Analysis</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Demo of Automatic 3D FE &amp; BE Meshing</td>
<td>01-Jan-98</td>
<td>Yes</td>
</tr>
<tr>
<td>&quot;Thread&quot; through Layout-Solid Model-Mechanical/Elec</td>
<td>01-Jan-98</td>
<td>Yes</td>
</tr>
<tr>
<td>Alpha of Integrated (Mech, Elect) Solver w/GUI</td>
<td>01-Jul-98</td>
<td>Yes</td>
</tr>
<tr>
<td>Beta of Inegrated Solver (Mech, Elect)</td>
<td>01-Jan-99</td>
<td>Yes</td>
</tr>
<tr>
<td>Alpha of Integrated Thermal Solver</td>
<td>01-Jan-99</td>
<td>Yes</td>
</tr>
<tr>
<td>Alpha of Harmonic Analysis</td>
<td>01-Apr-99</td>
<td>Yes</td>
</tr>
<tr>
<td>Alpha of Angled Sidewall analysis</td>
<td>01-Jul-99</td>
<td>Yes</td>
</tr>
<tr>
<td>Beta of Angled Sidewall analysis</td>
<td>01-Oct-99</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Model Builder</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alpha of Model Builder</td>
<td>01-Apr-99</td>
<td>Yes</td>
</tr>
<tr>
<td>Beta of Model Builder</td>
<td>01-Oct-99</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Circuit Refinement Suite</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Schematic Enhancements, MATLAB</td>
<td>01-Oct-98</td>
<td>Yes</td>
</tr>
<tr>
<td>Validated multidimensional MEMS Model, VHDL Inte</td>
<td>01-Apr-99</td>
<td>Yes</td>
</tr>
<tr>
<td>Full mixed domain model support</td>
<td>01-Oct-99</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Synthesis and Verification Suite</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Demo of Mixed Tech Block Place and Route</td>
<td>01-Oct-98</td>
<td>Yes</td>
</tr>
<tr>
<td>Beta of Multi-domain Extraction</td>
<td>01-Jan-99</td>
<td>Yes</td>
</tr>
<tr>
<td>Beta of Context Sensitive DRC</td>
<td>01-Jul-99</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Table 8: Schedule of deliverables.
3. Schedule

The program schedule is shown in Figure 42 below.

![Program Schedule Diagram]

Figure 42: Program Schedule

4. Personnel Status

Table 9 depicts the Team members, email addresses, and their current responsibilities.

<table>
<thead>
<tr>
<th>Dr. Barry Dyne</th>
<th><a href="mailto:barry.dyne@tanner.com">barry.dyne@tanner.com</a></th>
<th>Program Manager. Leader for Solid Modeling, FE/BE Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eugene Chen</td>
<td><a href="mailto:eugene.chen@tanner.com">eugene.chen@tanner.com</a></td>
<td>Contributor. Schematic.</td>
</tr>
<tr>
<td>Dr. Peisheng Gao</td>
<td><a href="mailto:peisheng.gao@tanner.com">peisheng.gao@tanner.com</a></td>
<td>Contributor. 3D Solid Modeling, Visualization.</td>
</tr>
<tr>
<td>George Kardaras</td>
<td><a href="mailto:Kardaras@tanner.com">Kardaras@tanner.com</a></td>
<td>Contributor. 3D rendering and results postprocessing.</td>
</tr>
<tr>
<td>Name</td>
<td>Email</td>
<td>Role</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hee Jung Lee</td>
<td><a href="mailto:Heejung.lee@tanner.com">Heejung.lee@tanner.com</a></td>
<td>Contributor. Process Definition, Behavioral Model Development</td>
</tr>
<tr>
<td>Dr. Jian Gong</td>
<td>Jian <a href="mailto:Gong@tanner.com">Gong@tanner.com</a></td>
<td>Contributor: FEA Mechanical and Thermal Solvers</td>
</tr>
<tr>
<td>Dr. David Bernstein</td>
<td><a href="mailto:David.bernstein@tanner.com">David.bernstein@tanner.com</a></td>
<td>Contributor: Meshing, Self-consistent co-solvers</td>
</tr>
<tr>
<td>Dr. Ananth Sethuraman</td>
<td><a href="mailto:ananth.sethuraman@tanner.com">ananth.sethuraman@tanner.com</a></td>
<td>Contributor: BE EM Solvers</td>
</tr>
<tr>
<td>Dr. Mary Ann Maher</td>
<td><a href="mailto:maryann.maher@tanner.com">maryann.maher@tanner.com</a></td>
<td>Task Leader. Leader for Behavioral Model Builder and Library tasks.</td>
</tr>
<tr>
<td>Dr. Scott Wedge</td>
<td><a href="mailto:scott.wedge@tanner.com">scott.wedge@tanner.com</a></td>
<td>Task Leader. Leader for Schematic and Simulation.</td>
</tr>
<tr>
<td>Dr. Harald von Sosen</td>
<td><a href="mailto:harald@tanner.com">harald@tanner.com</a></td>
<td>Contributor. Modeling and Simulation</td>
</tr>
<tr>
<td>Dr. Alex Khainson</td>
<td><a href="mailto:alex@tanner.com">alex@tanner.com</a></td>
<td>Contributor. Mixed technology Place and Route</td>
</tr>
<tr>
<td>Dr. Doug Jerardi</td>
<td><a href="mailto:jerardi@tanner.com">jerardi@tanner.com</a></td>
<td>Contributor. Context sensitive DRC</td>
</tr>
<tr>
<td>Mr. Nicolas Williams</td>
<td><a href="mailto:nicolas.williams@tanner.com">nicolas.williams@tanner.com</a></td>
<td>Contributor. Extract.</td>
</tr>
<tr>
<td>Mr. Jin Luo</td>
<td><a href="mailto:jin.luo@tanner.com">jin.luo@tanner.com</a></td>
<td>Manager: Application Engineering and Training</td>
</tr>
<tr>
<td>Aki Saggio</td>
<td><a href="mailto:aki.saggio@tanner.com">aki.saggio@tanner.com</a></td>
<td>Contract Administration</td>
</tr>
<tr>
<td>Prof. Stephen Senturia</td>
<td><a href="mailto:sds@mtl.mit.edu">sds@mtl.mit.edu</a></td>
<td>MIT Consultant: Behavioral Modeling</td>
</tr>
<tr>
<td>Dr. Selden Crary</td>
<td><a href="mailto:crary@umich.edu">crary@umich.edu</a></td>
<td>Univ. of Mich. PI: Model Builder</td>
</tr>
<tr>
<td>Rod Morison</td>
<td><a href="mailto:rod.morison@tanner.com">rod.morison@tanner.com</a></td>
<td>Vice President, Tanner EDA. Fiscal Review</td>
</tr>
</tbody>
</table>

Table 9: Individuals contributing to the MEMS program.

5. Talks/Presentations

Presented/Published:

- Microelectromechanical Systems and the Multiuser MEMS Process Short Course, December 2-4, 1997, MCNC Research Triangle Park, NC. Mary Ann Maher provided instruction on the use of L-Edit for MEMS design to attendees of this three day course on the MUMPS process. Keith Schaefer attended the course to learn more about the MUMPS process, in relation to solid modeling requirements.


- Microelectromechanical Systems and the Multiuser MEMS Process Short Course, April 15-17, 1998, MCNC Research Triangle Park, NC. Mary Ann Maher provided instruction on the use of L-Edit for MEMS design to attendees of this three day course on the MUMPS process.


MISSION
OF
AFRL/INFORMATION DIRECTORATE (IF)

The advancement and application of Information Systems Science
and Technology to meet Air Force unique requirements for
Information Dominance and its transition to aerospace systems to
meet Air Force needs.